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1.  INTRODUCTION 

Overview 

Today's energy-efficient windows can dramatically lower the heating and cooling costs associated with 

windows while increasing occupant comfort and minimizing window surface condensation problems.  

However, consumers are often confused about how to pick the most efficient window design for a 

commercial building. Product information typically offers window properties:  U-factors or R-values, 

Solar Heat Gain Coefficients or Shading Coefficients, and air leakage rates. However, the relative 

importance of these properties depends on site- and building-specific conditions. Furthermore, these 

properties are based on static evaluation conditions that are very different from the real situation a 

window will be used in.  

A computer tool such as COMFEN can help architects and builders pick the most energy-efficient and 

cost-effective window for a given application. It calculates heating and cooling energy use and associated 

costs as well as peak heating and cooling demand for specific window products. Users define a specific 

"scenario" by specifying the building type, geographic location, orientation, and window configuration. 

Users also specify size, shading, and thermal properties of the window they wish to investigate.  

Update information, future releases, and program information about COMFEN and other software tools 

(such as WINDOW, THERM, and Optics) from the Windows and Daylighting Group at LBNL can be 

found on the World Wide Web at URL: http://windows.lbl.gov, in the Software section. To obtain 

COMFEN, WINDOW, or THERM, check the web site for the current downloadable version. 

 

http://windows.lbl.gov/
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2.  QUICK START 

2.1.  Getting started 

 Install the COMFEN program (see Chapter 3, "Installation"). 

 When the program is installed, double click on the COMFEN4 icon. 

 

Figure 2-1. Click on the COMFEN icon in the Programs/LBNL Software list. 

 The Startup Menu screen that appears allows you to either start a new project or open existing 

projects. There are a few example projects in COMFEN, which are listed under Recent Projects. 

Projects are collections of “scenarios” or façade designs, that can be compared.  

 

Figure 2-2. The Startup Menu screen allows you to create a new project or open already defined projects. 
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2.2.  Quick Tour of COMFEN 

To take a tour of the program, we will start by opening an existing project, West Shading Example. 

2.2.1.  Main Screen 

Below is the main screen when you first open the program. Following discussions will explain in more 

detail each section on this screen. The program opens with the Overview / Summary results tab being 

displayed. 

Figure 2-3. The Overview / Summary View. 

 

Project 
Explorer 

Results 
tabs 

Menu 

Toolbar 

Project 
Name 

Location 
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Project Explorer 

The Project Explorer is the primary navigation tool in the Project. In the Project Explorer, there are two 

tabs, Scenarios and Libraries. 

Figure 2-4. The Project Explorer. 

Scenarios The Scenarios tab shows a list of all the Scenarios in the current Project 

Libraries The Libraries tab has three subtabs: 

 Window Library Tab:  this shows the records in the Window Library. There is 
one default window. You can highlight a window and drag it onto the façade in 
the Edit Scenario View. 

 Glazing System Tab:  this shows the records in the Glazing System Library. 
You can highlight a glazing system and drag it onto a window in the Edit 
Scenario View. 

 Shading System Library Tab:  this shows the records in the Shading System 
Library. You can highlight a shading system and drag it onto a window in the 
Edit Scenario View. 

Figure 2-5. The Libraries Tab subtabs. 

Window Library Tab 

Glazing System Library Tab 

Shading System Library Tab 

The column width can be 
adjusted by pulling the right 
hand column boundary to 
the left or right 

Clicking on a 
column header 
causes the list to 
be sorted by that 
column. The 
default sort is ID 

The entire Explorer 
column can be 
resized by pulling 
this icon to the left or 
right 

This icon toggles the 
details (everything 
except ID and Name) 
to show or not to show  

The Libraries tab has three subtabs: 
- Window Library 
- Glazing System Library 

- Shading System Library 

List of Scenarios 
in the current 
project 

List of items 
in each of 
the 
Libraries 

Right click on a 
Scenario for a list of 
actions that can be 
applied to that 
Scenario 
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Scenario Visualization 

Under the Comparison Tab, you can show up to four of the scenarios by dragging them from the Project 

Explorer Scneario tab to the upper right part of the screen. Highlight the desired Scenarios in the 

Scenarios tab and drag your mouse to the right.  

Figure 2-6. Highlight up to four scenarios and drag them to the right under the Comparison tab. 

Figure 2-7. The scenarios will be displayed in “3D” and results, if they exist, will be shown below each. 

The Scenario Visualization section of the main screen shows the geometry of any Scenarios in the Project 

Explorer that you have dragged into the Visualization section of the screen. They do not have to be 

simulated to be in the Visualization section, but results will only show in the Results section if they are 

simulated. 
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Figure 2-8. The elements of the Scenario Visualization. 
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Visualization for this 
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2.2.2.  Menu 

 

Figure 2-9. The COMFEN menu options. 

The COMFEN menu options are: 

COMFEN The menu options are: 

 About COMFEN: This option shows the program version 

 Preferences: Controls various settings in the program 

 Hide COMFEN  

 Quit 

Project The File menu is used to control projects and general program options 

 New Project: Starts a new project, opening up the Project Properties dialog box 

 Open Project: Opens a list of projects that are in the current database 

 Close Project: Closes the current project 

 Project Properties: Opens the Project Properties dialog box, which contains the 
Project Name, Building Type, Project North and Location 

 Delete Projects: Allows you to delete projects from the database 

 Import Project Definition from CSV file: Allows you to import projects from a 
CSV text file. All projects must be closed for this option to be active 

 Export current project results to CSV: Exports the Annual Energy Use results 
for all the scenarios in the currently open project to a CSV file, which can then 
be opened in a spreadsheet program. 

Scenarios The Scenarios menu is used to control the Scenarios within Projects. 

 Create Scenario: Creates a new scenario within the currently opened project 

 Copy Scenario:  Makes a copy of the highlighted scenario 

 Import Scenario from Project: Shows all the scenarios in all the projects in the 
current database, and allows import of those scenarios into the current project 

 Delete Scenario: Deletes the highlighted scenario 

 Rename scenario: Renames the highlighted scenario 

 Add Window to Scenario: When in Scenario Edit mode, opens the New 
Window dialog box to define a new window on the scenario facade 

 Add Exterior Shade to Scenario: When in Scenario Edit mode, opens the New 
Wall Shade dialog box to define a new fin or overhang. 

 Export compared scenarios images to PNG: Exports one image per compared 
scenario as a PNG file to the location specified.  

 Calculate All: Calculates the results for all the scenarios in the currently open 
project 

 Calculate Selected: calculates the results for the highlighted scenarios 

Libraries The Libraries menu is used to access all the Libraries 

 

Help The Help menu is used to view the program version number as well as the program 

Help file. 
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2.2.3.  Toolbar 

Figure 2-10. The COMFEN Toolbar. 
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2.3.  Open an Existing Project 

When you first open a Project that is already in the database, the Project Explorer is shown on the left side 

of the screen and the Overview Tab is shown on the right side of the screen. If the scenarios have not been 

calculated, there will be yellow triangles to the left of the scenarios and there will not be graphs in the 

Summary tab. 

Figure 2-11. The Overview screen, which appears when you open an existing project. 

You can calculate the results at this point, and they will appear in the Summary tab. To calculate the 

results, highlight as many scenarios as you want to calculate, and click on the Lightning Bolt toolbar, or 

right click and choose the Calculate Enery Use option. 

Yellow 
triangles 
indicate that 
results need 
to be 
calculated 

The Summary section is 
blank because the 
scenarios have not been 
calculted 
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Going to the Comparison tab will allow you to see the Scenario Visualization view, but it will be blank 

until you highlight the scenario from the Scenario List on the left, and drag it them to the right.  

Figure 2-12. Drag scenarios to the right in the Comparison tab. 

Then you will be able to see the “3D” versions of the scenarios, but there will still not be results until the 

scenarios are calculated. 

Figure 2-13. The 3D visualizations are shown in the Comparison tab. 
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If the scenarios have a triangle icon to the left, this means that they do not have current results (and 

therefore the Results Section will be blank) and must be simulated. 

Figure 2-14. The yellow triangle icon to the left of the scenario means it needs to be calculated 

To calculate the results, select as many scenarios as desired, then click the lightning bolt tool bar button, 

and the program will start to run the Energy Plus simulation program for each scenario. 

Figure 2-15. Highlight the scenarios to be calculated and press the Lightning Bolt toolbar button. 

As the calculations are proceeding, a status box will appear. 

Figure 2-16. A status bar will appear as the scenarios are calculated. 

 

Select all the scenarios 
that need to be simulated 

Click the Calculate icon and Energy Plus will 
start simulating the scenarios 

This icon means that the 
results are not current and 
they must be calculated 

As the calculations proceed, a 
status bar appears 
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 When the calculations are finished, the results will appear in the Results Section 

Figure 2-17. When the results have been calculated, the results will display under the Comparison tab. 

 

 

 

 

When the 
calculations are 
finished, the results 
will appear in the 
Results Section 



2.  QUICK START 

2-12 OCTOBER 2, 2012 COMFEN 4.1 

2.3.1.  Viewing the Scenario Details 

In order to view the details of a scenario, you need to open the Edit Scenario Viewby double clicking on 

the graphic of the scenario. 

Figure 2-18. The Scenario tab on the Edit Scenario View. 

Double click on the Scenario 
Visualization to open the Edit Scenario 
View, which will show the details of the 
scenario 
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Edit Scenario View 

The Edit Scenario View allows you to enter information about the geometry of the space to be modeled, 

the lighting controls, the lighting and equipment loads, and the number of people in the space. 

Scenario Tab 

The scenario tab contains the title of the scenario, as well as information about the geometry and loads of 

the scenario. 

Figure 2-19. The Scenario tab on the Edit Scenario View. 

The Geometry section 
contains the dimensions 
of the scenario, as well as 
the orientation of the front 
of the facade 

The Environment section 
contains information about 
lighting and glare controls, as 
well as loads for lighting, 
equipment and people 

The Windows 
tab lists the 
properties of 
each window 

The Wall Shades 
tab lists the 
properties of the 
overhangs and fins 

Click Done 
to close this 
view and 
return to the 
Scenario 
Visualization 
view  

The Glazed Wall tab lists 
the properties of the 
Glazed Wall Assembly if 
it is defined 

The Cost tab 
shows cost 
details by 
component 
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Windows Tab 

The Windows Tab shows a list of all the windows on the façade. Double click on any window in either 

the list or the graphic and the Edit Window dialog box appears, which allows you to view and edit the 

window information.  

 Figure 2-20. The Window tab and the Edit Window dialog box 

To see (and edit) the details of a particular 
window, double click on the window in 
either the list or the graphic, which causes 
the Edit Window dialog box to appear 

The Edit Window dialog box 
allows the properties of the 
window to be viewed or edited. 

Click on the Glazing 
System, Shading System 
and Frame Type pulldown 
lists to select the 
appropriate options. 

Click Done to 
close the dialog 
box and return 
to the Edit 
Scenario View 

Window 
name 

Click this icon  
to view the 
Glazing and 
Shading System 
IDs 

Click on the Operable 
Window type for 
natural ventilation 
modeling. 
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Edit Window dialog box 

The Edit Window dialog box allows you to view and edit all the information pertaining to the window.  

 

Figure 2-21. The Basic Info tab on the Edit Window dialog box. 

Sill Height 

Window Height 
(outside frame to 
outside frame) 

Distance from Left wall  
(from Left hand edge of frame) 

Window Width 
(outside frame to 
outside frame) 
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Wall ShadesTab 

The Wall Shades Tab shows a list of all the overhangs and fins on the façade. Double click on any 

overhang or fin in either the list or the graphic and the Edit Wall Shade dialog box will appear, which 

allows you to view and edit the window information.  

Figure 2-22. The Wall Shades tab and Edit Wall Shade dialog box. 

To see (and edit) the details of a particular 
overhang or fin, double click on the overhang or fin 
in either the list or the graphic. This will cause the 
Edit Wall Shade dialog box to appear. 

The Edit Wall Shades dialog box allows 
the details of the overhang or fin to be 
viewed and/or edited. Click Done to close 

the dialog box and 
return to the Edit 
Scenario View 



2.  QUICK START 

COMFEN 4.1 OCTOBER 2, 2012 2-17 

2.4.  Creating a New Project 

When first starting the program, click on the New Project choice under Create to start a new project. If 

you are already in the program, use the Project > New Project menu option to create a new project. 

 Figure 2-23. Click on New Project to start a project. 

The Create COMFEN Project will appear. There are several tabs with different information to be filled out 

about the project. 

General 

The General tab is used to give the project a name (required), a description (optional), and specify a 

building type (required). 

 

 Figure 2-24. The Project Properties “General” tab 

Click on New 
Project to 
start a project 

Project Name (required) 

Project Description (optional) 

Building Type (required) 
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Site 

The Site tab is used to define the properties of the site, such as location and project orientation 

 

 Figure 2-25. The Project Properties “Site” tab 

Cost 

The Cost tab is used to set overrides to the default costs in the program for lighting, HVAC, and utility 

rates. 

 Figure 2-26. The Project Properties “Cost” tab 
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the Scenario and in the Location  

Project North 
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Project North 
(for offset from cardinal orientations) 

Location 
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the records in the Location Library 

Default costs set 
by COMFEN 
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Lighting control 
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HVAC Equipment 
default costs 
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(from the Location Library) 

Locat Cost Adjustment Factor 
 (from the Location Library) 

Cost Override inputs than 
can be szet by the user 
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HVAC 

The HVAC tab is used to set some default properties for how the HVAC system is operated 

 Figure 2-27. The Project Properties “HVAC” tab 

The HVAC system is 
fixed as a Packaged 
Single Zone system 

The way that outdoor air 
is controlled can be set 

for the project 
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2.4.1.  Defining Scenarios 

When you are starting a new Project, there are no scenarios defined. To define a new scenario, go to the 

Scenarios menu and select Create Scenario 

 Figure 2-28. Creating a new scenario.  

In the Scenarios menu, 
click on the Create 
Scenario choice 

Click on the Add New 
Scenario toolbar button 

OR 

The Create New 
Scenario dialog box will 
appear. 

Enter the appropriate 
information. 

Click OK when you are finished, and the new 
scenario will appear in the Project Explorer 
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2.4.2.  Edit Scenario 

To edit the scenario (so that you can add windows, shades, etc), do the following: 

 Double click on the scenario name in the Project Explorer to open the Edit Scenario View 

Figure 2-29. Open the Edit Scenario View from the Project Explorer 

Double click on the 
Scenario name in 
the Project 
Explorer and the 
Edit Scenario View 
appears 
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2.4.3.  Add Windows 

There are several ways to add a window to a scenario: 

 From the Project Explorer, select the Libraries tab, Window Library icon, and drag a window to the 

facade 

OR 

 From the Edit Scenario Windows tab, click on the  button and the enter the appropriate 

information in the New Window dialog box. From this dialog box you can also define the 

Glazing System, Shading System and Frame Type from the appropriate tabs. 

Click on the 
Libraries tab 

Click on the 
Window icon 

Highlight the 
desired window 
and drag it to the 
façade wall 

When the window is 
on the wall, it can be 
moved by clicking on it 
and dragging it to the 
desired position 

The window can also 
be resized by clicking 
on the lower right 
corner and dragging it. 

To add a window, click 
on the “+” button and the 
New Window dialog box 
will appear 

Windows tab 



2.  QUICK START 

COMFEN 4.1 OCTOBER 2, 2012 2-23 

OR 

 From the Scenarios menu, click on the “Add Window to Scenario” menu choice, which will 

display the New Window dialog box. From this dialog box you can also define the Glazing 

System, Shading System and Frame Type from the appropriate tabs. 

Figure 2-30. Add Windows to a Scenario. 
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Defining the Glazing System for the Window 

There are several ways to define or change a glazing system for a window: 

 From the Project Explorer, select the Libraries tab, Glazing System Library icon, highlight 

the desired glazing system, and drag it to the window. 

OR 

 When defining the window, in the New Window dialog box, click on the Glazing System 

pulldown list or the spy glass next to it and the records in the Glazing System Library will 

be displayed. Highlight the desired glazing system and click the Select button. 

Click on the 
Libraries tab 

Click on the 
Glazing 

System icon 

Highlight the 
desired Glazing 
System and drag 
it to the window 

The ID of the glazing 
system will change, if 

the  toolbar toggle 
is on. 

All the records 
in the Glazing 
System Library 
will show in 
this list  

In the Edit Window tab, click on either the 
Glazing system pulldown or the spy glass 
icon to open a dialog box showing the 
records in the Glazing System Library  

Click the Select 
button 
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OR 

 Double click on the window to open the Edit Window dialog box. Click on the Glazing 

System tab to define or change the glazing system for the window. Highlight the desired 

glazing system and click the Done button. 

Double click on the 
window to open the 
Edit Window dialog 

box 

Click on the Glazing system pulldown list 
or spy glass icon to see the records in the 
Glazing System Library. Highlight and 
select the desired choice, as shown in the 
previous example. 
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Windows Tab on Edit Scenario View 

The Windows Tab shows a list of all the windows on the façade. Double click on any window in either 

the list or the graphic and the Edit Window dialog box appears, which allows you to view and edit the 

window information.  

Figure 2-31. The Windows tab and the Edit Window dialog box 

To see (and edit) the details of a particular 
window, double click on the window in either 
the list or the graphic, which causes the Edit 
Window dialog box to appear 

The Edit Window dialog box allows the properties 
of the window to be viewed or edited. 

The Glazing System, Shading 
System and Frame can be 
edited, as well as the 
Operating type of the window 
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Edit Window dialog box 

The Edit Window dialog box allows you to view and edit all the information pertaining to the window. 

There are several tabs in this dialog box: 

Figure 2-32. The Dimensions and Position on the Edit Window dialog box. 

The Frame Width is the frame dimension when looking at the frame in elevation. 

Figure 2-33. The Frame Width. 

The Setback is the distance from the outside surface of the wall that the window is inset into the wall. 

Figure 2-34. The Setback. 

Frame Width 

Outside Inside 

Setback 

The Window Area is the area of 
the window including the frame. 

The Vision Area is the area of the 
glazing system inside the frame. 



2.  QUICK START 

2-28 OCTOBER 2, 2012 COMFEN 4.1 

Figure 2-35. The Edit Window dialog box defining glazing system, operating type, shading system and frame type. 
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2.4.4.  Add Wall Shades (Overhangs and Fins) 

To add overhangs and fins to the scenario, go to the Wall Shades tab in the Scenario Edit view, and click 

on the + button. A dialog box will appear which allows you to define overhangs and fins.  

Figure 2-36. Defining an overhang or fin. 

Step 1: Go to the 
Wall Shades tab 

Step 2: Click on 
the + button 

Step 3: Fill in the 
information about 
the shade 
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3.  INSTALLATION 

3.1.  Hardware Requirements 

First, make sure your computer system meets these specifications: 

 At least 16 MB of random access memory (RAM), configured as extended memory. 32 MB of RAM is 

preferred for optimum operation. 

 Microsoft Windows XP™, Windows Vista™ or Windows 7™. 

 Hard disk drive with at least 100 megabytes of available disk space. 

 Monitor and mouse. 

3.2.  Setup 

The installation program can be downloaded from the LBNL website at 

http://windows.lbl.gov/software/comfen 

Once you have downloaded the installation program, follow these steps to install the program: 

1. Using Windows Explore, browse to where the installation file was downloaded and double click on it. 
 

Figure 3-1. Double click on the downloaded installation file. 
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2. A Welcome window will display. Click the Next button to proceed with the installation, or Cancel to 
stop. 

 

Figure 3-2.  The initial COMFEN Welcom window. 
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3. The Software License Agreement window will display next. Read through the license and make sure 
you agree to all the terms before proceeding. To proceed with the installation, click on the Yes button, or 
click on No to stop.  

 

Figure 3-3.  The COMFEN License Agreement window. 
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4. The Ready to Install the Program window will display next.  Press the Install button to begin the 
installation. 

 

Figure 3-4.  Ready to Install the Program screen.  
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5. The next screen to display is the Setup Status screen, which shows the files being installes. 

 

Figure 3-5.  The Setup Status screen shows the files being installed. 
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6. When the installation is complete, the InstallShield Wizard Complete screen will be displayed. Press 
Finish to finalize the installation. Sometimes this screen will appear, but you can’t click the Finish 
button. In this case, click on another area of the screen, then click back to this screen and you should be 
able to click on the Finish button. 

 

Figure 3-6.  The InstallShield Wizard Complete screen will display when the installation is finished. Press the Finish button to 

finalize the installation. 

 

7. Setup will automatically put a COMFEN Icon in the Programs menu under the LBNL Software group. 

 

Figure 3-7.  Program icon to run COMFEN. 
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3.3.  Running COMFEN  

To run COMFEN, go to the Programs menu, single click on the LBNL Software group, and single click on the 

COMFEN icon. Additionally, there may be a shortcut icon in the main list of programs, depending on the 

operating system: In either case, click on the shortcut, and the program will start. 

 

Figure 3-8.  Click on the COMFEN 3.1 shortcut icon to start the program.  
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COMFEN will open to the following view and you can begin using the program by selecting either a recent 

Project to open or creating a New Project. 

 

Figure 3-9.  The first screen when COMFEN starts  
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3.4.  Uninstalling COMFEN 

If you need to uninstall COMFEN, follow the steps below. 

1. Go to the Control Panel and go to the Programs or Add/Remove Programs (depending on the 

operating system) choice. Highlight the previous version of COMFEN and select uninstall or remove 

(depending on the operating system). 

 

Figure 3-10. Go to Control Panel and click on Programs or Add/Remove Programs. 

2. The program will ask if you want to completely remove the application. Click OK to uninstall the 

program, or Cancel to cancel the uninstall process. 

 

Figure 3-11. Click OK to continue with the uninstall process. 
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3. While the program is being uninstalled, the Setup Status screen will appear. 

4. When the uninstall process is complete, the Maintenance Complete screen appears. Click Finish to 

complete the uninstall. 

 

Figure 3-12. Click Finish to complete the uninstall process. 
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3.5.  Troubleshooting 

When you first run the program after installing it, the results may show as zeros after the first calculation. If 

you have this problem, close the program, run it again, and the problem should go away. 

Please send E-mail to COMFENhelp@lbl.gov if you have any trouble running the program. 

mailto:RESFENhelp@lbl.gov
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4.  PROGRAM DESCRIPTION 

4.1.  Program overview 

COMFEN, short for commercial fenestration, is a simple single-zone facade analysis tool based on 

EnergyPlus, a powerful building simulation engine. COMFEN can be used to evaluate a range of 

facade configurations in order to understand the impact of different design variables on facade 

performance. After defining a building type, location and zone properties (dimensions and loads 

from equipment and people and fenestration layout), several additional scenarios can be quickly 

created and compared side-by-side. Orientation, window-to-wall ratio (WWR), glazing type and/or 

shading can easily be varied in order to assess their impact on energy use, peak loads, daylighting 

and thermal and visual comfort.  

COMFEN includes a number of libraries with predefined facade components, including glazing, 

shading, material, wall and spandrel libraries. In addition to fixed exterior fins and overhangs, 

automated interior or exterior venetian blinds and roller shades can be evaluated using one of a 

number of predefined shading control options. . The shading system library, developed based on 

performance data for commercially-available products, incorporates venetian blinds, roller shades, 

metal mesh screens and glazing-integrated venetian blinds. 

 

Figure 4-1. The COMFEN Project Comparison Summary screen 
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The primary steps to completing a COMFEN calculation are: 

 Defining the “scenarios” (alternative facade configurations for comparison)  

 Calculating the scenarios. This is done by highlighting one or more of the scenarios in the list on the 

left of the screen and clicking the lightning bolt icon . Alternatively, scenarios can be calculated 
by clicking the right mouse button and choosing Calculate performance. The program will calculate 
the heating, cooling, lighting, and fan energy use for each scenario, peak energy consumption, CO2 
emissions, annual daylight levels, and visual and thermal comfort. 

 Comparing scenarios of interest. Upon the completion of the calculations, the user can compare 
select scenarios side-by-side by navigating to the Comparison tab and then dragging select scenarios 
from the scenario list on the left of the screen to the blank area under the Comparison tab.  

This chapter describes the program in detail. 

4.1.1. COMFEN database 

COMFEN projects are saved in a single database. The default database that comes with the program is 
comfen.sqlite and the location of this file can be determined by accessing COMFFEN > Preferences > database 
tab. The same database is automatically opened each time the user starts up COMFEN unless they change the 
path of the database in this dialog box.  

When COMFEN starts, the program prompts the user to select an existing project, or create a new 

project, window, glazing, or shading system. Double-clicking on one of the existing projects opens 

the project screen. 

 

Figure 4-2.   Opening Screen 

 

 

 



 4.  PROGRAM DESCRIPTION 

COMFEN 4.1 OCTOBER 2, 2012 4-3 

 

4.1.2. Menu 

The COMFEN menu options are: 

COMFEN The COMFEN menu can be used to view the program version number and modify 
general program options. 

Project The Project menu is used to control projects  

Scenarios The Scenarios menu is used to control Scenarios within projects. 

Libraries The Libraries menu is used to access all of the libraries 

Help The Help menu provides links to the COMFEN website, websites discussing various 
aspects of facade design, and an online glossary  

  

COMFEN 

About COMFEN Lists program version number and program contributors 

Preferences Opens the Application Settings dialog box, which has five tabs: 

 Basic Settings:  The verbose logging allows for detailed logging of what happens in 
the program to the program log file (application-log.txt), i.e. in addition to warning 
and error messages, all debug messages are logged as well. The log file is mainly 
used for troubleshooting software problems.  

     

Figure 4-3.   Preferences > Basic Settings 

 Database:  This sets the database that COMFEN opens when the program is started. 
The default database that comes with the program is comfen.sqlite. However, by 
copying and renaming the default database the user can easily create multiple 
databases as needed. The user can locate a database by clicking the browse button 
and navigating to the file. Compact database option allows user to defragment the 
database and reduce its file size.  A backup copy of the database is created before 
compacting.  
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Figure 4-4.   Preferences > Database  

 EnergyPlus: This tab controls some basic settings for the Energy Plus simulation 
program, the underlying calculation engine for COMFEN:  

- The Site-to-source multiplier determines whether energy use results are displayed 
in terms of site or source energy. Site energy is energy used by the building on 
site (as measured at the meter), while source energy is a measure that accounts 
for energy consumed on site as well as the energy consumed during the storage, 
transport and delivery of the fuel to the building.  Source energy is a better 
indicator of building environmental performance impact. By default, the 
multiplier is set to 1; electricity use results are displayed in terms of site energy.  

- If the Calculate illuminance box is checked, COMFEN calculates hourly 
horizontal illuminances throughout the space for a specific date and time. The 
results are displayed under the Comparison > Overview results tab in the form 
of color illuminance maps.  

- When “Show EnergyPlus error log” or “Show in.imf file” are selected, these two 
files open automatically if EnergyPlus crashes.   

 

    

Figure 4-5.   Preferences > EnergyPlus 

 WINDOW 6:  This tab specifies the WINDOW 6 database from which additional 
glazing systems will be imported into COMFEN. 
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Figure 4-6.   Preferences > WINDOW6 

 Cost:  The cost tab provides user with the option to override the baseline glass cost. 
For a definition of baseline glass cost, see the cost section.  

 

Figure 4-7.   Preferences > Cost 

Hide COMFEN Minimizes the COMFEN window 

Quit Closes COMFEN 

Project 

New project Opens the Create COMFEN project dialog box where new project properties can be 
entered (project name, description, building type, project North, location, etc.). See the 
next section for more detailed information on creating projects. 

Open project Opens the Open COMFEN Project dialog box, which shows all of the projects currently 
defined in the currently open database. Projects can be opened by double-clicking or 
highlighting a project and then selecting Open. 
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Figure 4-8.   Project > Open Project  

Close project Closes the currently open project, and returns to the startup menu screen. 

Project  
Properties Opens the Project Properties dialog box, which shows the details of the currently open 

project. The project properties can be changed here as needed and are discussed in more 
detail in the next section. 

  

Figure 4-9.   Project > Project Properties  

Delete projects Opens the Delete COMFEN project dialog box, which shows the list of projects in the 
currently open database. Highlight a project, and click the Delete Selected to delete the 
entire project from the database. 



 4.  PROGRAM DESCRIPTION 

COMFEN 4.1 OCTOBER 2, 2012 4-7 

 

Figure 4-10.   Project / Delete Projects 

Import project  
definition from  
CSV file  Allows the user to import project and scenario information using previously created 

tabulated inputs in csv format. This option is especially useful for projects with multiple 
scenarios. All projects must be closed in order to import a csv file (the option is grayed 
out if a project is open). 

Export project 
results to CSV  Option that allows the export of COMFEN project results (annual and peak energy by 

end use, average illuminance levels, visual and thermal comfort, etc.) and basic scenario 
properties (orientation, WWR, glazing, shading system, lighting control setting, etc.) to a 
CSV file. 

Scenarios 

Create Scenario Opens the Create New Scenario dialog box. 

Copy Scenario Creates a copy of highlighted scenario. 

Import Scenario 
from Project Allows the user to import a select scenario from another project. 

Delete Scenario Deletes highlighted scenario. 

Rename Scenario Renames highlighted scenario. 

Add Window  
to Scenario Adds a window to scenario. Unless scenario is active, this option is grayed out.     

Add Exterior  

Shade to Scenario Adds fixed exterior projection (overhangs, fins, etc.) to scenario. Unless scenario is 
active, this option is grayed out.     

Export compared  
scenarios images   
to PNG Exports thumbnail images of select scenarios in *.png format. 

Calculate All Calculates performance of all scenarios in project 

Calculate Selected Calculates performance of highlighted scenarios.  To select multiple scenarios in explorer 
hold shift or ctrl key down while making selections with the left mouse button. 
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Libraries 

The library menu allows the user to access all system and component libraries: 

 Windows 

 Glazing systems 

 Shading systems 

 Frames 

 Glass 

 Gas  

 Walls 

 Spandrels 

 Materials  

 Locations 

Import glazing system 
From WINDOW 6  Allows the user to import a glazing system from a WINDOW 6 database.  

Import IGDB data… Allows the user to update the glass library using a COMFEN *.sqlite database file that 
can be downloaded from the COMFEN website. See section on glass library for more 
information on the IGDB database. 
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4.1.3. Project  

To create a new project, select New Project from the Project menu. The Create COMFEN Project 

dialog box contains the same inputs as the Project Properties dialog box and includes the following 

tabs: 

General Lists project name, project description, building type and vintage.  

  

 Project Name: Field used to provide a unique name for the project. 

 Project description: Field for user comments about project.  

 Building type:  Building type determines several default values, including 
occupancy schedules, heating and cooling setpoints, and default outdoor air flow 
rate. The following building/space type options are available: 

 Office (office space) 
 Mid-rise residential (apartment)  
 Hotel (guest room) 
 Retail (point of sale) 
 School (classroom) 

A more detailed description of the different building types and schedule assumptions 
is provided in the Calculation assumptions section. 

Site Lists project North, location, default wall and Wall R-value. 

    

Project North: Defines the overall project orientation, measured clockwise from true 
North. A project with a Project North of 0° faces true North. The value specified for 
Project North is added to the scenario orientation definition (North, South, East or West) 
to calculate the “resolved” orientation. For example, a scenario facing South with a 
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Project North of 45° will in effect face southwest (45° degrees west of South) and its 
“resolved” orientation will be 45° + 180° = 225.° Default: 0 (project faces true north); 
Legal values: 0-359; Units: degrees. 

 

 

 

 

 

 

 

 

 

Figure 4-11.  Illustration of project North axis 

 Location: Field used to provide a unique name for the project. This drop-down will 
determine the weather data that will be used for the simulation. 

 Default Wall: This is the default exterior wall construction assigned to the project 
based on the project's location. When the user specifies the project location, an 
ASHRAE-90.1-compliant wall is automatically assigned as the default wall for the 
project. See components and libraries section for information on creating and 
assigning custom walls. 

 Wall R-value: This is the R-value corresponding for the default exterior wall.  

 

Cost The cost tab provides user with the option to override several default first cost values 
(e.g. lighting fixtures and controls, HVAC, etc.), utility rates for electricity and gas, and 
location adjustment factor. See cost section for a more detailed explanation of cost data. 

project North axis (here 
project is rotated 30° 
clockwise from true North) 

true 

North  

30°  

COMFEN 

zone 
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HVAC Lists general information on HVAC system and outdoor flow rate. 

  

 HVAC system: The default HVAC system is presently a packaged single zone 
system for all building types.  

 Outdoor air control: This section lists the default outdoor air flow rate used for 
ventilation. The user can override the air flow control type (flow/person or 
flow/area) and flow rate. 
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4.1.4. Scenario  

To create a new scenario, select Create Scenario from the Scenarios menu. This opens the Create New 

Scenario dialog box, shown in the image below, where new scenario information can be entered, 

including space dimensions, orientation and load information. The scenario orientation can be 

specified at one of the four cardinal directions (North, South, East, West). If the facade is not facing 

these cardinal orientations, this can be accounted for by entering a value in the Project North box in 

the Project Properties dialog box. 

   

Figure 4-12.   Create New Scenario 

After creating the enclosure for the scenario and inputting load information through the Create New Scenario 
dialog box, scenario inputs can be further edited in the scenario edit screen shown on the next page. The edit 
screen can be accessed by 1) double-clicking on the scenario under the scenario tab on the left side of the 
screen or 2) double-clicking on the image of the scenario in the Comparison tab.   

The scenario edit screen consists of the following tabs: 

 Scenario tab: tab where general scenario parameters, including geometry, orientation, loads and 
lighting controls are defined. The lighting control pulldown contains three choices for lighting 
and daylighting controls: none, continuous and stepped. See the calculation assumptions section 
for a more detailed description of lighting control options. 

Windows: Tab where window configuration is defined. Windows are added by clicking on the 

green “+” icon  in the upper-right hand corner of the tab, which brings up the New Dialog 

box. The new window inputs include window dimensions and position, glazing system, shading 

system (all systems except for fixed exterior projections) and frame type. Double-clicking on any 

entry in the table list view will bring up the edit window dialog box. Windows are deleted by 

highlighting the window and clicking the red “-“ icon . 
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 NOTE: The glare control checkbox will turn on the glare control option, meaning that a shading 
system will be activated (deployed) when the glare index setpoint is reached. The glare index 
setpoint is 22 and this value cannot be changed by the user. Additional shading control options 
can be specified under the shading system properties.  

 Wall Shades:  Tab where fixed exterior projections such as horizontal overhangs and vertical fins 

are defined. Similar to window definition, wall shades are added by clicking on the green “+” 

icon  in the upper-right hand corner of the tab, which brings up the new wall shade definitions 

screen. Wall shades are deleted by highlighting the shade and clicking the red “-“ icon .  

Scenario tab: tab where general scenario parameters, including geometry, orientation, loads and 

lighting controls are defined. The lighting control pulldown contains three choices for lighting 

and daylighting controls: none, continuous and stepped. 
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Figure 4-13.  Scenario tab 
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4.2.  Facade components and libraries 

This section discusses construction components and COMFEN libraries in detail. The libraries contain 

a range of predefined facade components such as windows, glazing systems, shading systems and 

frames as well as locations. They also include a comprehensive list of glazing products from a range 

of commercial glazing manufacturers. New entries can be created in all libraries except for the glass 

and gas libraries.  

The COMFEN facade components and libraries discussed in this section include the following  

Glass Layers 

Gas Layers 

Glazing Systems 

Frames 

Windows 

Shading Systems 

Glazed Wall Assembly 

Materials 

Walls 

Spandrels 

Locations 

4.2.1.  Glass layers 

The glass library contains entries from the International Glazing Database (IGDB) – a database 

containing measured performance data for commercially-available glass products. This performance 

data is submitted by manufacturers to LBNL, where it undergoes a technical and peer review prior to 

its incorporation in the IGDB. While the latest version of the IGDB database is automatically installed 

with COMFEN, it is updated bimonthly by LBNL in an effort to ensure that it contains all of the latest 

commercially-available products. COMFEN users are encouraged to periodically update their 

libraries by downloading a COMFEN *.sqlite IGDB update file from the COMFEN online Knowledge 

Base. 

Below is a description of select fields in the glass library: 

NFRC ID The ID field in the glazing system edit view refers to the glass or gas layers, and displays 
the NFRC identification number from the IGDB used in WINDOW 6 software. This field 
cannot be edited by the user. 

Name The IGDB filename for the glass layer or the name of the gas layer. These names come 
from the respective glass and gas selection lists, and cannot be edited by the user. 

Thickness The thickness of the glass or gas layer. The glass layer thickness values cannot be edited, 
but the gap (gas) layer thicknesses can be edited by the user. Units: mm 

Source Lists the IGDB version.  
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Emis1 Emissivity of the front surface of the glass layer. This value is 0.84 for uncoated glass. 
The emissivity values for front and back can be used to determine if a layer should be 
“flipped” so that the coating is on the correct surface.  This field cannot be edited by the 
user. 

Emis2 Emissivity of the back surface of the glass layer. See comment for front emissivity above. 

 

Figure 4-14.  Definition of front and back glass layer surfaces 

4.2.2.  Gas layers 

The entries in the COMFEN gas library come from a database that is installed with COMFEN, which 

contains the standard gases defined in the LBNL WINDOW software programs. The figure below 

shows the current gases available for glazing systems in COMFEN. The gas layers are used in the 

creation of COMFEN glazing systems. 

 

Figure 4-15.  COMFEN gas library 

4.2.3.  Glazing systems 

 

Glazing system library 

There are approximately 50 predefined glazing systems in the Glazing System Library, which 

includes both several generic glazing systems as well as a limited selection of commercially available 

insulated glazing products (ID# 100 and beyond). A glazing system can consist of a single glass layer 

(e.g. similar to the first entry in the image below), or of two or more glass layers separated by a gas 

layer. Any glazing systems defined in the glazing system library can be assigned to a window, 

whether it is a window in the window library or a window in the scenario edit screen.  New glazing 

systems can be added to this library as needed, by either creating the assembly directly in COMFEN 

or importing a glazing system from the WINDOW glazing system library. 
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Figure 4-16.   Glazing system library list view 

The ID of the glazing system is automatically generated in sequence by COMFEN. When glazing 

systems are imported into COMFEN, the ID from WINDOW will not be kept, but a new ID will be 

assigned based on the records existing in the COMFEN glazing system library. 

The user can specify a unique glazing system name under the name field. Existing entries based on 

commercially available products follow the a specific naming format: 

 Uncoated double glazing:  

<Manufacturer> -- <substrate #1> <substrate #2> <gap fill> 

 Double insulated glazing with a low-e or solar control coating: 

<Manufacturer> -- <coating name> <coating surface no.> <substrate #1> <substrate #2> <gap fill>  

 Triple insulated glazing with a low-e or solar control coating: 

<Manufacturer> -- <coating name> <coating surface no.> <substrate #1> <substrate #2> <substrate #3> <gap fill>  

 

Creating a new glazing system 

To create a new glazing system, select the new button in the lower right-hand corner of the glazing 

system library. Under the Create New Glazing System screen (see image below), drag glass and gas 

layers from the right-hand list view to create desired assembly.  
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Figure 4-17.  Create new glazing system screen 

 
Layer no. 
field The layer no. field (far left column in the image below) identifies the layer sequence 

number in the glazing system. The first layer is the layer on the outside (exterior) of the 
glazing system, the last layer is the layer on the inside (interior) of the glazing system. 
Gas spaces are also counted as layers. The outside and inside layers have to be a glass 
layers, and each glass layer has to be separated by a gas fill.  
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Figure 4-18.  Glass and gas layers are numbered from outside to inside 

The Calculate using WINDOW 6 button calculates the thermal and optical properties for the glazing 

system (Tvis, SHGC, U-factor and thickness) using WINDOW 6 calculation algorithms. If the glazing 

system is imported from WINDOW 6, these values will usually already be calculated and will appear 

in this section.  

 

Figure 4-19.  The Results section of the Glazing System Library 

Tvis   Visible transmission of the complete glazing system 

SHGC   Solar Heat Gain Coefficient for the whole glazing system 

U-factor  U-factor for the complete glazing system, in Btu/h-ft-F (IP units) or W-m2-K (SI units) 

Thickness  Thickness of the complete glazing system in in. (IP units) or mm (SI units) 

 

Importing a glazing system from WINDOW 6 

To import a glazing system from WINDOW 6, navigate to the main glazing system library tab 

(Libraries > glazing systems) and click on the Import from WINDOW6 button at the bottom of the 

screen.  

 

Figure 4-20.   Import from WINDOW6 Glazing System Option 

Or go to Libraries > Import glazing system from WINDOW 6. 

This will bring up a list of glazing systems in the WINDOW 6 database. Navigate to the desired 

system and click Import. 

NOTE: COMFEN cannot import WINDOW 6 glazing systems that have shading systems associated 

with them. 

Outside  

(Exterior) 

Inside  

(Interior) 
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Figure 4-21.  WINDOW 6 glazing system import screen 
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NOTE: The WINDOW 6 library from which glazing systems will be imported is specified through Preferences under the 
COMFEN menu. If you want to change the database, click on the Browse button and navigate to the desired WINDOW 
6 database. 

  

 Figure 4-22.  Select a WINDOW 6 database from which to import glazing systems 
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4.2.4.  Frames 

The frame library consists of a predefined set of frames. The thermal properties of these frames are 
characteristic of commercially-available systems. Due to limitations in the Energy Plus simulation engine, 
highly conductive frames such as aluminum frames without a thermal break cannot be modeled. The U-factor 
cannot exceed 1.1 Btu/h-ft2-F (6.2 W/m2-K). In order to account for the effect of framing with a U-factor 
exceeding this limit, the user could increase the area of the modeled framing. 

 

 

Figure 4-23.   Frame library list view 

The frame edit dialog box consists of the following inputs: 

 

Figure 4-24  Edit frame dialog box 
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4.2.5.  Windows 

The window library stores predefined windows which can later be easily added to a scenario. A COMFEN 
window consists of a glazing system, frame and shading system. A window from the library is added to a 
scenario by dragging the window from the Libraries tab in the scenario explorer on the left side of the screen 
(see image below).  

 

Figure 4-25  Edit frame dialog box 

 

Figure 4-26  Window edit screen 
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4.2.6.  Shading systems 

The shading system library is used to model venetian blinds, shades (cloth blinds, roller shades, 

drapes, etc.) and fixed exterior screen shading systems. The types of shading systems that can 

currently be modeled in COMFEN are based on the modeling capabilities of the EnergyPlus 

simulation engine used by COMFEN. Venetian blinds and roller shades can be controlled 

automatically using one of the control options in COMFEN. The list of systems and available 

modeling options are summarized in more detail in the sections below. 

 

Venetian blinds 

COMFEN allows modeling of interior, exterior and in-between-glass venetian blinds, which can be 

defined under the shading system properties screen (see image below). All of these systems can be 

modeled as fixed or automated using one of COMFEN’s predefined shading control algorithms. To 

access the shading system properties screen, double-click on any shading system under the shading 

system library tab, or select “New” to create a new system. 

 

 

 

 

 

 

Figure 4-27.  Venetian blinds can be defined in three  
different locations relative to the glazing system 
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Figure 4-28.  Shading system properties screen  

Slat Orientation Orientation of the venetian blind, either: 

 Horizontal - slat is parallel to window sill 

 Vertical - slat is perpendicular to window sill 

Slat geometry 

Slat width The width of the slat. Units: inches (IP), mm (SI) 

Slat Spacing The spacing between slats. Units: inches (IP), mm (SI) 

Slat Tilt The rotation of the slat, measured clockwise from the glazing outward normal to the slat 
outward normal.  Units: degrees 
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Figure 4-29.  Slat angle definition  
(Source: EnergyPlus Input Output Reference)  

 

Slat Thickness The thickness of the slat. Units: inches (IP), mm (SI) 

Slat Conductivity The conductivity of the slat material. Units: Btu/h-ft-oF (IP), W/m-K (SI) 

Min Slat Tilt The minimum slat tilt, used for the “Block Beam Solar” control. Units: degrees 

Max Slat Tilt The maximum slat tilt, used for the “Block Beam Solar” control. Units: degrees. 

NOTE: COMFEN will not run if slats overlap, so when slat spacing is less than the slat width, make sure that the 
minimum and maximum slat angles account for the fact that slat angle will be greater than 0 (or smaller than 180) 
when blinds are completely closed.  

NOTE: Inbetween venetian blinds can only be simulated in double and triple glazing systems. 

 

Slat Optical Properties 

Transmittance, 

Beam Solar Slat transmittance for direct beam solar radiation. 

Transmittance, 

Diffuse Solar Slat transmittance for diffuse solar radiation. 

Transmittance, 

Beam Visible Slat transmittance for direct beam visible radiation. 

Transmittance, 

Diffuse Visible Slat transmittance for diffuse visible radiation. 

Reflectance, front 

Beam Solar Reflectance on the front surface of the slat for direct beam solar radiation. 

Reflectance, front 

Front surface 

Back surface 
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Diffuse Solar Reflectance on the front surface of the slat for diffuse solar radiation. 

Reflectance, front  

Beam Visible Reflectance on the front surface of the slat for direct beam visible radiation. 

Reflectance, front 

Diffuse Visible Reflectance on the front surface of the slat for diffuse visible radiation. 

Reflectance, back 

Beam Solar Reflectance on the back surface of the slat for direct beam solar radiation. 

Reflectance, back 

Diffuse Solar Reflectance on the back surface of the slat for diffuse solar radiation. 

Reflectance, back 

Beam Visible Reflectance on the back surface of the slat for direct beam visible radiation. 

Reflectance, back 

Diffuse Visible Reflectance on the back surface of the slat for diffuse visible radiation. 

 

Slat IR thermal hemispheric properties 

Transmittance Slat transmittance for infrared radiation 

Emissivity, Front Emissivity of the front surface of the slat. Default value: 0.9 

Emissivity, Back Emissivity of the back surface of the slat. Default value: 0.9 

Shading control 

The following control options are presently available in COMFEN. Some of the options are limited to 

specific shading systems. The default shading system setpoints are listed in Table 4-3. 

NOTE: Timestep is equal to 15 minutes. 

 Always on: Shading is always lowered/deployed 

 Always off: Shading is always raised/retracted 

 On If Schedule Allows: This control cannot be used in COMFEN because it does not allow 
scheduling of controls 

 On If High Solar On Window: Shading is lowered/deployed if beam solar radiation plus 
diffuse solar radiation incident on the window exceeds the setpoint (W/m2). The setpoint value 
is specified in the control setpoint 1 field. 

 On If High Horizontal Solar:  Shading is lowered/deployed if total (beam plus diffuse) 
horizontal solar irradiance exceeds setpoint (W/ m2). The setpoint value is specified in the 
control setpoint 1 field. 

 On If High Outdoor Air Temp: Shading is lowered/deployed if outside air temperature 
exceeds setpoint (°C). The setpoint value is specified in the Control setpoint 1 field. 
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 On If High Zone Air Temp: Shading is lowered/deployed if the room air temperature in the 
previous timestep exceeds setpoint (°C). The setpoint value is specified in the control setpoint 1 
field. 

 On If High Zone Cooling: Shading is lowered/deployed if the room cooling rate in the 
previous timestep exceeds setpoint (W). The setpoint value is specified in the control setpoint 1 
field. 

 On If High Glare: Shading is lowered/deployed if the daylight glare index (DGI) at the room’s 
first daylighting reference point (sensor #1) exceeds the maximum glare index (22). The 
calculation is performed assuming that the occupant is positioned at the first daylighting 
reference point is at desk level - 2'-6" (0.76 m) above floor level.  

The glare view azimuth (i.e. rotation of the sensor) determines the rotation of the occupant from 
the facade. By default, the azimuth (measured clockwise from an axis normal to the facade) is 
set to 90°, i.e. the sensor is rotated 90° clockwise from the facade so that it faces one of the zone 
side walls. For a south-facing zone and a glare view azimuth angle of 90° the occupant faces 
west, while for a west-facing scenario and a glare view azimuth angle of 90° the occupant faces 
north, and so on. The glare view azimuth is equal to 90° regardless of orientation. 
 
Presently the user cannot change the occupant’s position or glare view azimuth angle through 
the COMFEN interface. They can, however, change the glare view azimuth angle by accessing 
the comfen_settings.xml file in the settings folder. NOTE: COMFEN must be closed when editing 
the glare view azimuth angle in the comfen_settings.xml file in order for the change to take effect.  

 On Night If Low Outdoor Temp / Off Day: Shading is lowered/deployed at night if the 
outside air temperature is less than the setpoint (°C). Shading is raised/retracted throughout 
the day. The setpoint value is specified in the control setpoint 1 field. 

 On Night If Low Inside Temp / Off Day: Shading is lowered/deployed at night if the room air 
temperature in the previous timestep is less than the setpoint (°C). Shading is raised/retracted 
throughout the day. The setpoint value is specified in the control setpoint 1 field. 

 On Night If Heating / Off Day: Shading is lowered/deployed at night if the zone heating rate 
in the previous timestep exceeds the setpoint (W). Shading is raised/retracted throughout the 
day. The setpoint value is specified in the control setpoint 1 field. 

 On Night If Low Outside Temp  / On Day If Cooling: Shading is lowered/deployed at night if 
the outside air temperature is less than setpoint (°C). During the day, shading is 
raised/retracted if the zone cooling rate in the previous timestep is non-zero. The setpoint 
value is specified in the control setpoint 1 field. 

 On Night If Heating / On Day If Cooling: Shading is lowered/deployed at night if the zone 
heating rate in the previous timestep exceeds setpoint (W). During the day, shading is 
raised/retracted if the zone cooling rate in the previous timestep is non-zero. The Setpoint 
value is specified in the control setpoint 1 field. 

 Off Night  / On Day If Cooling And High Solar On Window: Shading is raised/retracted at 
night. Shading is lowered/deployed during the day if the solar radiation incident on the 
window exceeds setpoint (W/ m2) and if the zone cooling rate in the previous timestep is non-
zero. The setpoint value is specified in the control setpoint 1 field. 

 On Night / On Day If Cooling And High Solar On Window: Shading is lowered/deployed 
throughout the night. During the day, shading is lowered/deployed if the solar radiation 
incident on the window exceeds setpoint (W/ m2) and if the zone cooling rate in the previous 
timestep is non-zero. The setpoint value is specified in the control setpoint 1 field. 

 On If High Outside Air Temp And High Solar On Window: Shading is lowered/deployed if 
the outside air temperature exceeds Setpoint 1 (°C) and if the solar radiation incident on the 
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window exceeds setpoint 2 (W/ m2). The setpoint values are specified in the control setpoint 1 
and Control setpoint 2 fields. 

 On If High Outside Air Temp And High Horizontal Solar: Shading is lowered/deployed if 
the outside air temperature exceeds the setpoint (°C) and if the horizontal solar radiation on the 
window exceeds setpoint 2 (W/m2). The setpoint values are specified in the control setpoint 1 
and control setpoint 2 fields. 

Control  

Setpoint 1 For controls that require one setpoint, enter it here. See the control list above. 

Control  

Setpoint 2 For controls that require two setpoints, enter the second one here. See the control list 
above. 

Slat Angle for 

Control for 

Venetian Blinds The following slat control options are available for venetian blinds: 

 Fixed slat angle:  Slat angle is fixed at the angle defined under the slat tilt input 
field. 

 Block beam solar:  Slat angle is adjusted at every simulation timestep (15 minutes) 
in order to block direct solar radiation from coming into the room. The minimum 
slat tilt (min. tilt) and maximum slat tilt (max. tilt) entries under the "Details" section 
of the shading properties dialog box define the range of slat rotation.  

The list of available shading control types in COMFEN is based on the modeling features of Energy 

Plus. The Energy Plus Input/Output Reference documentation (found on their website at 

http://apps1.eere.energy.gov/buildings/energyplus/energyplus_documentation.cfm) contains detailed 

information about each control.  
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Table 4-1. Shading System Controls Strategies 

Shading Control 
Setpoint 1 

default value 

Setpoint 1 

Units 

Setpoint 1 

default value 

Setpoint 2 

Units 

Always On N/A N/A N/A N/A 

On If High Solar On Window 
- 

- 

W/m2   (SI) 

Btu/h-ft2 (IP) 
N/A N/A 

On If High Horizontal Solar 
- 

- 

W/m2   (SI) 

Btu/h-ft2 (IP) 
N/A N/A 

On If High Outdoor Air Temperature 
- 

- 

°C  (SI) 

°F  (IP) 
N/A N/A 

On If High Zone Air Temperature 
- 

- 

°C  (SI) 

°F  (IP) 
N/A N/A 

On If High Zone Cooling 
- 

- 

Watts  (SI) 

BTU/hr  (IP) 
N/A N/A 

On If High Glare* N/A N/A N/A N/A 

On Night If Low Outdoor Temp And Off Day 
- 

- 

°C  (SI) 

°F  (IP) 
N/A N/A 

On Night If Low Inside Temp And Off Day 
- 

- 

°C  (SI) 

°F  (IP) 
N/A N/A 

On Night If Heating And Off Day 
- 

- 

Watts  (SI) 

BTU/hr  (IP) 
N/A N/A 

On Night If Low Outdoor Temp And On Day If Cooling 
- 

- 

°C  (SI) 

°F  (IP) 
N/A N/A 

On Night If Heating And On Day If Cooling 
- 

- 

Watts  (SI) 

BTU/hr  (IP) 
N/A N/A 

Off Night And On Day If Cooling And High Solar On 
Window 

- 

- 

W/m2   (SI) 

Btu/h-ft2 (IP) 
N/A N/A 

On Night And On Day If Cooling And High Solar On 
Window 

- 

- 

W/m2   (SI) 

Btu/h-ft2 (IP) 
N/A N/A 

On If High Zone Air Temp And High Solar On Window 
- 

- 

°C  (SI) 

°F  (IP) 

0 

0 

W/m2   (SI) 

Btu/h-ft2 (IP) 

On If High Zone Air Temp And High Horizontal Solar 
- 

- 

°C  (SI) 

°F  (IP) 

0 

0 

W/m2   (SI) 

Btu/h-ft2 (IP) 

On If High Outdoor Air Temp And High Solar On Window 
- 

- 

°C  (SI) 

°F  (IP) 

0 

0 

W/m2   (SI) 

Btu/h-ft2 (IP) 

On If High Outdoor Air Temp And High Horizontal Solar 
- 

- 

°C  (SI) 

°F  (IP) 

0 

0 

W/m2   (SI) 

Btu/h-ft2 (IP) 

 

* When this option is selected, no setpoint input is required; shading is automatically retracted when the Daylight Glare Index exceeds 
22. 
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4.2.7.  Glazed wall assembly 

In addition to the option of creating individuals windows, i.e. punched windows within a scenario, the user 
can create a series of windows that fill up a part of or the whole facade by using the glazed wall assembly 
option. This feature is particularly useful for modeling storefronts and curtain wall assemblies as it makes it 
possible to create these quickly and easily.  

 

Creating a glazed wall assembly 

To create a glazed wall assembly, open the New glazed wall assembly dialog box by clicking on the "add 
glazed wall assembly icon" in the toolbar: 

Figure 4-30.   Toolbar with Glazed Wall Assembly icon 

 

This will pull up the glazed wall assembly dialog box: 

 

 

Figure 4-31  New glazed wall assembly dialog box 

 

NOTE: Only one glazing assembly can be created within a scenario and a scenario with a glazed wall 
assembly cannot have a punched window, or vice versa. 

“Add glazed wall assembly” icon 
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The inputs for this dialog box are explained below: 

 Default frame:  This is the frame that will be used for the glazed wall assembly. Only one type of 
frame can be specified. 

 Assembly Height:  Height of the glazed wall assembly, measured from the bottom edge of the 
first framing member to the top edge of the last member. 

 Assembly Width:  Width of the glazed wall assembly, measured from the outside of the first 
framing member to the outside of the last member. 

 Count:  Number of horizontal or vertical framing elements. Minimum number of horizontal or 
vertical framing elements is 2. 

 Offset from bottom:  Position of the bottom edge of glazed wall assembly relative to the bottom 
edge of the scenario. 

 Offset from left:  Position of the left edge of glazed wall assembly relative to the left edge of the 
scenario. 

The table below the inputs lists each framing element (horizontal elements on the left and vertical on the 
right), along with its width, spacing and distance: 

Width:  Width of framing element, equal to the width of the framing defined under the default frame 
input above. 

NOTE: Since it is assumed that the glazed wall assembly represents a "slice" through a glazed wall, 
perimeter framing elements are automatically modeled at 1/2 of the width of the framing member selected as 
the default frame.   

Spacing - framing spacing, measured from center line to center line of framing member. The spacing 
of the first framing member is always 0. 

Distance - distance of framing from edge of scenario elevation (either left or bottom edge) and the 
center line of framing member. 

 

After defining the type and position of the framing, the user specifies the default glazing and shading for 
the assembly (individual glazing units can be later edited interactively in the scenario elevation view).  

        

Figure 4-32.   Select the Glazed Wall Assembly Default Shading System and Glazing System 

When the glazed wall assembly framing and glazing is defined, click Done to save changes and exit.  
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Figure 4-33  Framing member spacing and distance 

 

Editing a glazed wall assembly 

Individual lites can be edited in the interactive scenario view if needed by left-clicking on a lite to highlight 
the lite and then right-clicking within the highlighted area to bring up the edit glazed wall assembly menu:  

 

Figure 4-34.   Glazed wall assembly menu 

From this menu, the user can opt to edit a glazing system, assign or delete a shading system, specify an 
operable window or a spandrel. "Edit glazed wall assembly" will bring up the New glazed wall assembly 
dialog box. 

NOTE: Any changes (e.g. glazing, shading an spandrel definitions) made in the interactive scenario view 
will be overwritten if changes are made under the New glazed wall assembly dialog box.  
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To select multiple lites, hold the shift key while drawing a window starting with the window's upper left 
corner. Any lites that overlap with the drawn window will be highlithed. At this point, if you right-click, 
the menu with the options listed above will appear.  

 

Figure 4-35  Multiple glazing unit selection 

 

                

 

TIP: To display the glazing, shading system and spandrel info markers, click on the information icon in the 
toolbar.  

 

General glazed wall assembly properties are summarized under the glazed wall tab. This is also where the 
user can select edit button to return to the glazed wall assembly dialog box.  

 

Information icon 
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Figure 4-36  Glazed wall tab 

4.2.8.  Materials 

The material library contains a range of predefined construction materials used for wall and spandrel 

assemblies. New materials can be easily added to the library. A number of properties need to be 

defined for a typical material in order to ensure that heat transfer through the material is modeled 

correctly by the program – see image of material properties dialog box.  

 

Figure 4-37.   Material library list view 

Material properties dialog box input fields: 

ID A unique material ID automatically generated when a material is created 
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Name A unique material name assigned by user 

Group Primary material library subdivisions (e.g. masonry, boards and finishes, insulation, 
cladding, membranes, etc.)  

Subgroup Group subdivision 

Source Source from which material properties were obtained, e.g. ASHRAE Handbook of 
Fundamentals 

Type This field is used to characterize the material's thermophyscial properties, primarily its 
thermal storage capacity. The field also determines the required inputs for the material 
properties dialog box. COMFEN recognizes three different types of materials: 

1. Default (with thermal capacity): A material with thermal storage capacity; this is 
the default material type for materials. This option should typically be selected as 
it will ensure that EnergyPlus will account for the thermal mass of the material 
and thus evaluate the effect of transient conduction. This material type requires 
that a range of thermophysical properties be specified.  

Required inputs:  Conductance, density, specific heat, emissivity, (front), 
emissivity (back), thickness, and optical properties: solar transmittance and 
reflectance (front and back), visible transmittance and reflectance (front and 
back), and IR transmittance. 

2. Lightweight (no thermal capacity):  Similar to a "Default (no thermal capacity)" 
material, however the material's thermal storage capacity is not taken into 
account. Option should only be used for materials with minimal thermal storage 
capacity (e.g. insulation).  

Required inputs:  Same as default material type, except density and specific heat 
are not required. Also, thermal resistance (R-value) is required in place of 
conductance. 

3. Air gap: This option is used to define an air gap between layers in a construction. 
Similar to a lightweight material, the thermal capacity of an air gap layer is 
negligible. However since the layer is not exposed to any external environment, 
surface properties such as absorptance and reflectance are not a required input.  

Required inputs: Thermal resistance (R-value) and thickness 
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Figure 4-38.   Material properties dialog box 

 

Energy Plus Documentation: Note that the corresponding Energy Plus material 
descriptors for the COMFEN material types listed are "Material," "Material:NoMass" 
and "Material:AirGap." For a more detailed description of the Energy Plus material 
types please refer to the "Group – Surface Construction Elements" chapter in the Energy 
Plus Input Output Reference. 

Roughness Field used to define material roughness, a property which influences convection 
coefficients used in the calculation of surface heat transfer. Inputs range from very rough 
to very smooth. Only default and lightweight materials require a roughness input. The 
following table lists roughness categories and provides examples of specific construction 
materials. 

 

Table 4-2. Example of different roughness materials 

 

Roughness index Example material 

Very rough Stucco 

Rough Brick, rough plaster, rough stone, unfinished terra cotta tile 

Medium rough Concrete 
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Medium smooth Clear pine, wood siding 

Smooth Smooth plaster, smooth stone 

Very smooth Glass, painted pine, polished metal 

 

  Energy Plus Documentation: For a more detailed description of roughness and the 
calculation methodology for exterior convection coefficients please refer to the “Group – 
Simulation Parameters: SurfaceConvectionAlgorithm: Outside” and “Group - Surface 
Construction Elements: Material” chapters in the Energy Plus Input Output Reference and 
the “Outside Surface Heat Balance – Outdoor/Exterior Convection” chapter in the 
Energy Plus Engineering Reference. 

Comment Field for optional comments 

 

4.2.9.  Walls 

The scenario wall construction can be changed under the scenario tab, where any wall from the wall library 
can be selected from a drop-down menu. All of the walls listed under this drop-down can be edited and 
deleted under the wall library.  

 

Figure 4-39.   Scenario Wall Construction Reference 

Wall library 

To access the wall library, go to the menu - Libraries > Walls. The first few walls in the library represent 
wood stud walls that comply with the requirements of ASHRAE Standard 90.1; these walls meet ASHRAE 
minimum wall R-value requirements for specific climate zones. The effect of thermal bridging at the wood 
studs within the cavity is already accounted for, i.e. frame spacing and width, requirements for cavity 
insulation and continuous insulation (c.i.) outboard of the cavity match ASHRAE prescriptive method 
requirements. When a user creates a new project, an ASHRAE-compliant wall is automatically assigned to 
the project as the default wall based on the project's location and climate zone.    
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Figure 4-40.   Wall Construction Library List View 

Creating a new wall  

To add a new wall to the COMFEN library, go to Libraries > Walls to pull up the wall library, and then click 
"New." This pulls up the wall create/edit screen. The table on the left side of the screen shows the wall 
assembly. Wall layers are added by dragging entries from the material library on the right side of the 
screen. Layers in the wall construction table can be reordered by dragging the entries. The table columns are 
described below. 

 The first column represents the layer number. Layers are counted from the outermost 
(outside) layer to the innermost (inside) layer.  

ID Unique material ID# 

Material Material name 

Framing Indicates whether the layer is continuous or discontinuous. For the latter option, the 
layer is designated as either framing or cavity. This option is intended for modeling 
layers with thermal bridging such as wood stud walls with insulated cavities (COMFEN 
cannot presently model steel stud cavities). The user specifies % framing area below the 
table. COMFEN calculates the effective wall R-value using the isothermal planes method 
which accounts for the effect of thermal bridging through wood studs.  

Thickness  Thickness of the material layer 

R-value frame R-value of the layer designated as "framing"  

R-value cavity R-value of the layer designated as "cavity"  

 

Wall assembly characteristics 

% framing Width of framing/framing spacing * 100%. Range: 1 to 99% 

U-factor Effective U-factor for whole wall (accounts for effect of framing and outside and inside 
film coefficients). 

R-value Effective R-value for whole wall (accounts for effect of framing and outside and inside 
film coefficients) 
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Assembly thickness Effective wall thickness 

 

Figure 4-41.   Wall Construction Detail View 

NOTE:  While COMFEN can accurately model thermal bridging through wood stud cavities, it cannot 
presently calculate the resistance of a wall with highly conductive materials, such as metal studs. However 
sample steel stud walls have been provided in the wall library. 

NOTE:  When creating a wall, the following conditions must be met:  

1. The outermost and innermost layers of the construction must be air films (materials from the 
"film coefficient" group). 

2. A wall with a "composite" layer - a combination of two discontinuous materials such as wood 
studs (framing) with insulation in the cavity must have a continuous "enclosing" layer on 
either side of the composite: a "regular" or "lightweight" material type. The cavity and framing 
must be modeled as adjacent layers. 

3. If you define a material as a "cavity" in the wall construction table on the left-hand screen of the 
wall edit screen, you also have to define a "framing" material, and vice versa.  

4. Framing materials must come from the framing group in the material library and cavity 
materials must come from the air cavity or insulation group. 

5. Air spaces must be in between two other construction materials (i.e. material types "regular" 
and/or "lightweight"). Air spaces cannot be adjacent to one another. 
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Figure 4-42.   Creating a New Wall Construction 

 

Changing the default project wall 

The user can change the default project wall defined based on the project location (see Project > Project 
properties dialog box) at the scenario or project level. To change the wall for the scenario, double-click on 
the scenario in the explorer and go to the scenario tab. Under the Geometry and materials section, click on 

the search icon  to bring up a list of walls in the library. Highlight a wall of choice and click Select to 
assign wall to scenario.  

The default wall assigned to projects can also be changed under the location tab. To do this, go to the 
location library (Libraries > Locations) and double-click on the location (you may want to make a copy of 
the original location beforehand and edit the copy rather than the original location entry to conserve the 
defaults). Once open, select wall of choice under the default wall drop-down and save the revised location. 
Any project created with this location will now have the new default wall automatically assigned to it.   

 

4.2.10.  Spandrels 

Spandrels can only be assigned to scenarios with a glazed wall assembly. To assign a spandrel to a glazed 
wall assembly, highlight one or more glazing units in the scenario view. Right-click within the highlighted 
area to bring up the glazed wall assembly menu and select "Set to spandrel." This will bring up a list of 
spandrels in the library. Select the spandrel of choice and click "Select." To edit the spandrel, select "Set to 
spandrel" in the glazed wall assembly menu to once again bring up the list of options.   
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Figure 4-43.   Defining Spandrels 

Spandrel library 

To access the spandrel library, go to the menu - Libraries > Spandrels. The existing entries represent 
examples of typical spandrel construction. The user can add new spandrel constructions to the library as 
needed.  

 

Figure 4-44.   Material properties dialog box 
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Creating a new spandrel 

To add a new spandrel to the COMFEN library, go to Libraries > Spandrels to pull up the spandrel library, 
and then click "New." This pulls up the spandrel create/edit screen. Here, you can drag materials from the 
right-side of the screen to create a custom spandrel.  

NOTE:  When creating a spandrel, the following conditions must be met:  

1. The outermost and innermost layers of the construction must be air films (materials from the 
"film coefficient" group). 

2. Air spaces must be inbetween two other construction materials (i.e. material types "regular" 
and/or "lightweight"). There cannot be adjacent air spaces within the construction. 

3. Only glazing systems with up to three glass layers can be specified in a spandrel. 

4. Multiple glazing systems within a spandrel are not allowed; only one glazing system or glass 
layer can be used.  

 

 

Figure 4-45.   Spandrel Library Detailed View 
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4.2.11.  Locations 

The COMFEN location library contains weather data for a range of cities in the United States, Australia, 
Canada, India and Russia. Many of the locations also include additional data such as CO2 emissions factors, 
utility cost data, and default walls for each location.  

 

Figure 4-46.   Location library list view 
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Location Library List Detailed View – General Tab 

 

Figure 4-47.   Edit location Detailed view, General tab 

Location Library List Detailed View – Cost Tab 

 

Figure 4-48.   Edit location Detailed view, General tab 
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Creating a new location 

General tab 

Energy Plus Weather File 

  

Weather File Each location in the library references a weather file in Energy Plus (*.epw). New 
locations can be assigned to the library by selecting the New button at the bottom of the 
library list view screen.  
 
Weather data for additional locations can be downloaded from the Energy Plus weather 
data website: 
http://apps1.eere.energy.gov/buildings/energyplus/cfm/weather_data.cfm 
 
The Energy Plus website contains three types of files for  each location: the *.epw, *.stat, 
and *.ddy. The user should download the zip file, which contains all three files.  
 
When creating a new location, the user must specify the *.epw weather file location by 

clicking Browse under the General tab. An associated *.ddy must be located in the same 
folder as the *.epw file. Once the weather file has been loaded, the user must complete 
all of the missing fields. The require information for the Zone field can be found in the 
*.stat file by searching for the term “climate type” and looking up the ASHRAE 90.1 
climate zone designation.  

Location Information 

  

ID Automatically assigned by the program when making a new location. Not editable. 

Country Select from the choice of countries in the pulldown list when creating a new location 

City Type the name of the city for the new location 

State/Province A pulldown list of states / provinces will be shown for the United States and Canada. 
Otherwise, type the state / province in the input field. 

 

http://apps1.eere.energy.gov/buildings/energyplus/cfm/weather_data.cfm
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Envelope insulation  

 

 

Standard Building energy standard used to determine envelope insulation requirements for the 
location. Based on the required insulation levels (R-value) set by the standard, a default 
wall construction (listed under ASHRAE wall) is assigned to the location.  

Zone Location’s ASHRAE climate zone. The climate zone information is listed in the location’s 
*.stat file (summary weather data file), which can be downloaded from the Energy Plus 
website.  

ASHRAE wall A wall meeting the insulation (R-value) requirements of the standard listed in the 
Standard field. 

Default wall Default wall that is assigned to projects in the location. The user can use the construction 
listed under ASHRAE wall if they want to ensure that the construction meets the 
requirements of the standard listed under the Standard field, or they can assign a custom 
wall construction by selecting a wall from the drop-down list.  The walls listed here 
correspond to walls defined in the wall library.  

Wall R-value Effective wall R-value for the wall specified under the Default wall field. 

 

CO2 factor 

  

Electricity Average carbon emissions per unit of electricity generated by utility and nonutility 
electric generators. Default: data for the 1998-2000 time period (EIA, 2002). Since these 
factors can vary considerably by year for some U.S. states, it is recommended that the 
user input updated values if available. 

Gas Average carbon emissions per unit of natural gas. Default: 0.12 
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Cost tab 

Electricity rate 

  

Default rate The average price of electricity used by end-user in the commercial sector (EIA, 2011b). 
Units: $/Kwh (IP & SI). 

Rate Override Check the box if you want to use different data than the default. This will cause the 
input box to the right of the checkbox to become active and a new rate can be input. 
Units: $/Kwh (IP & SI). 

Comment Optional comment.  

 

Gas rate 

  

Default rate The average price of natural gas used by end-user in the commercial sector (EIA, 2011a). 
The price is inclusive of all tax, delivery, commodity, demand and other charges. Here, 
the commercial sector is defined as the sector encompassing nonmanufacturing 
establishments engaged in the sale of goods or services and local, State and Federal 
agencies engaged in nonmanufacturing activities.  Units: $/therm (IP); $/m3 (SI). 

Rate Override Check the box if you want to use different data than the default. This will cause the 
input box to the right of the checkbox to become active and a new rate can be input.  

Comment Optional comment.  
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Local Cost Adjustment Factor 

  

Default The labor and materials cost adjustment factor that is multiplied by the base cost the 
final total scenario cost. Based on data from RS Means (2011). Units: % 

Override Check the box if you want to use different data than the default. This will cause the 
input box to the right of the checkbox to become active and a new value can be input. 
Units: %. 

References 

1. Energy Information Administration [EIA] (2002). [Table 1. 1998-2000 Average State-level Carbon 
Dioxide Emissions Coefficients for Electric Power]. Updated State-level Greenhouse Gas Emission 
Coefficients for Electricity Generation, 1998-2000. Retrieved from: 
http://www.eia.gov/FTPROOT/environment/e-supdoc-u.pdf 

2. Energy Information Administration [EIA] (2011a). [Commercial natural gas prices]. U.S. and state 
natural gas prices for wellhead, imports, exports, citygate, and end-use sectors. Retrieved from 
http://205.254.135.24/dnav/ng/ng_pri_sum_a_EPG0_FWA_DMcf_a.htm 

3. Energy Information Administration [EIA] (2011b). [Table 5B. Commercial Average Monthly Bill by 
Census Division, and State, 2009]. Electric Sales, Revenue, and Average Price 2009. Retrieved from 
http://205.254.135.24/cneaf/electricity/esr/table5_b.html 
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4.3.  HVAC  

The default HVAC system is presently a packaged single zone system for all building types. Cooling and 
heating setpoints and schedules vary by building type (see appendix). The economizer option provides a 
means to reduce the need for cooling by introducing outdoor air when the conditions are favorable.  

4.3.1. Ventilation 

The default outdoor air flow rate is listed under the Project Properties > HVAC tab. The default flow rate type 
is set to flow/person and the volume of supplied air varies by building type. The user can override the air 
flow control type (flow/person or flow/area) and flow rate. 

 

Figure 4-49.  Project Properties > HVAC tab  

4.3.2. Economizer  

The economizer option in COMFEN is accessed from the scenario tab in the main screen (see figure below). 
The user can choose from three economizer control options: 

1.   Temperature – economizer is enabled when the cooling setpoint is not met and the drybulb 
temperature of outdoor air is lower than the dry-bulb temperature of return air. 

2.   Enthalpy - economizer is enabled when the cooling setpoint is not met and the enthalpy of outdoor 
air is lower than the enthalpy of return air. 

3.   Temperature and enthalpy – economizer is enabled when the cooling setpoint is not met and both the 
drybulb temperature and enthalpy of outdoor air are lower than the dry-bulb temperature and 
enthalpy, respectively, of return air. 
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Figure 4-50.  HVAC economizer  

4.4.  Lighting, Equipment and Occupancy Loads 

Default occupancy, lighting and equipment loads are set to the following when you create a new scenario:   

 
 

Figure 4-51.  Lighting, equipment and occupancy loads  

Lighting load:  1 W/ft2 
Equipment load:  0.75 W/ft2 
Occupancy:   1 person per zone 

NOTE: The loads listed above are the maximum loads, i.e. loads in a fully-occupied office. Actual loads at any given 
time will vary based on occupancy, lighting and equipment schedules (see appendix). 

NOTE: Since the current default loads presently do not vary by building type, it is recommended that the user review 
and adjust loads and occupancy based on building type.  
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4.5.  Daylighting and glare analysis 

A daylight analysis for scenarios can be performed under the Comparison tab. Here users can 

evaluate up to four scenarios side-by-side by calculating illuminance levels, luminances and occupant 

visual discomfort due to the glare. COMFEN uses two underlying simulation engines for daylight 

calculations – Energy Plus and Radiance, a state-of-the-art daylight simulation software. Some of the 

daylight simulations are calculated for the whole year while others are calculated for a user-defined 

date and time, i.e. point-in-time simulations. Radiance, a photometrically-accurate raytracing 

program, has been extensively tested and validated against physical measurements. The following 

sections discuss the types of analyses available and how to define different types of daylight 

simulations in more detail. 

4.5.1.  Point-in-time daylight simulations 

Point-in-time simulations refer to simulations conducted for a user-defined date and time. In contrast 

to annual daylight simulations, for which solar radiation data is obtained from the location’s weather 

file, point-in-time simulations require that the user specify the sky condition (e.g. clear, overcast or 

intermediate) for the calculation. In addition, some daylight calculations such as the glare analysis or 

the 3D contour map may require the user to specify the occupant’s position and angle of view. The 

next few pages discuss the Radiance-based daylight simulations, which include the illuminance 

contour maps found under the daylight tab and the glare analysis.  

Illuminance contour maps 

The illuminance contour maps generated in COMFEN under the Plan Contour and 3D Contour tabs 

show lines of equal illuminance for a plan view of the space and a user-defined perspective view. In 

order to generate either plan or perspective view contours for a set of scenarios, the user needs to 

define several simulation parameters in the Radiance toolbar. 

The Radiance toolbar options are defined below. Parameters on the right of the Radiance toolbar are 

used to adjust how results are displayed (e.g. legend maximum and divisions) but they do not affect 

the results, i.e. they will not change the calculated illuminance values.  

 

Figure 4-52.   Radiance toolbar 

Render Starts the simulation and updates image display 

Date Month and day for simulation  

Fidelity Precision of the simulation 

Camera  View angle for the perspective view (option is only displayed under the 3D contour tab) 

Sky Sky condition for the simulation (clear, overcast or intermediate) 

Exposure Displayed image brightness 
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Legend Max Maximum illuminance value displayed [Units: fc (IP), lux (SI)] 

Divisions Number of legend divisions 

  Export all renderings icon for exporting all renderings as individual *.png image files 

 Icon for displaying color legend for illuminance contour lines [Units: fc (IP), lux (SI)] 

NOTE: COMFEN automatically generates a rendering for 9 am, noon, and 3 pm for the specified date, however 
the user can override the default by selecting different times from the drop-down lists on the left of the display. 

 

 

Figure 4-53.   Specifying the time for the daylight simulation 

When the user clicks on the camera view icon, the “Position RADIANCE camera” dialog box appears. 

Here the user can define the x and y position of the camera (in ft or m) as well as the direction of the 

view. The position of the camera (i.e. how far it is from the window and side walls) is measured 

relative to the origin in the upper-left corner. The view direction is defined from the camera position. 

NOTE: By default, the angle of view represents a 180° cone of vision (fish-eye view), so there is no 

input for view angle or zoom.  

After defining simulation parameters, the user selects Render to run the simulations. Three 

renderings corresponding to three different times (default times are set to 9 am, noon, and 3 pm) will 

be generated for each scenario. Depending on the fidelity selected, the simulation may take some 

time. Upon making any changes to the scenario or to the simulation parameters in the Radiance 

toolbar, the user needs to click the Render button to recalculate and/or update the images. 

NOTE: If parameters on the left side of the Radiance toolbar are edited, the calculation is invalidated and results need 
to be recalculated. However, changing the options on the right side of the toolbar will only change how the image is 
displayed, so images only need to be updated (by clicking the Rerender button). The updating process may take a little 
bit of time, but it will be much shorter than a full Radiance calculation. 
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Figure 4-54.   Radiance camera dialog box for defining camera position and angle  

 

Figure 4-55.   Plan view illuminace contour lines  

View direction 

X 

Y 
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Figure 4-56.   Perspective view illuminace contour lines 

Glare analysis 

Glare analyses can be conducted under the Clear Sky and Overcast Sky tabs under Comparison > 

Daylight > Glare. Here, the user can create photo-realistic images of the space, apply falsecolor filters 

to show luminance ranges within the rendered view, and calculate the  Daylight Glare Index (DGI). 

The DGI is described in more detail further in the section. 

The Radiance toolbar under these tabs is quite similar to the toolbar under illuminance contour tabs. 

While most of the toolbar options have already been discussed above, the following options differ:  

Falsecolor  Checkbox used to apply a color mask to the rendered image to show luminances  

Legend Max  Maximum luminance value displayed in color mask [Units: cd/m2 (IP and SI)] 

  Icon for displaying the DGI scale dialog box 

 Color legend icon used for identifying color mask luminances values [Units: cd/m2 (IP 
and SI)]  

 

 

Figure 4-57.   Radiance toolbar 
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DGI is a measure of glare calculated based on the glare source (e.g. window) luminance, glare source 

size, surround background luminance, and the location of the glare source relative to the occupant's 

field of view. The fisheye camera view (180° cone of vision) defined in COMFEN approximates the 

human field of view (90° to either side, 60° up, and 70° down from the line of sight). The DGI value is 

displayed in the upper left corner of each rendering. The displayed values correspond to a subjective 

user assessment of glare displayed in the DGI scale dialog box: 

 

Figure 4-58.   DGI scale dialog box 

 

Figure 4-59.   Radiance toolbar 
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4.5.2.  Annual daylight simulations 

Annual illuminance values in COMFEN are calculated by Energy Plus based on the annual solar radiation 
data contained in the weather file used for the energy use calculations. These annual daylight simulations are 
automatically calculated by COMFEN when the user calculates the energy performance of scenarios. Results 
of these calculations are displayed in several tabs under the Comparison > Daylight tab (e.g. Annual 
Summary, Hourly Average, Seasonal Average and Illuminance Profiles).  

Calculations are performed for two predefined sensor points. The position of these sensor points is 

automatically assigned by COMFEN; the user presently has no control over these points: 

 Sensor # 1:  Daylight sensor #1 is positioned 2/3 of the primary daylight zone 
depth from facade wall (centered in the width of the facade zone) and 
positioned at desk height: 2'-6" (0.76 m) above the floor. Sensor #1 controls a 
fraction of the facade zone lights equal to the primary daylight zone depth 
divided by the facade zone depth. 

 Sensor # 2:  Any remaining depth in the facade zone is considered a secondary 
daylight zone.  Sensor #2 is positioned halfway between the primary daylight 
zone depth and the "back wall." Similar to sensor #1, the sensor is centered in 
the width of the facade zone and positioned at desk height: 2'-6" (0.762 m) 
above the floor. Sensor #2, if used, controls the remaining fraction of lights. 

 Zone Depth:  A primary daylight zone depth is calculated as the minimum of 
a) the room depth, b) 1.5 times the facade wall height, and c) 15 feet. 

4.5.3.  Daylight illuminance maps 

The user can choose to generate an additional set of illuminance results in the form of daylight illuminance 
maps. These maps are generated by Energy Plus and displayed under the Comparison > Summary tab. The 
maps display worksurface illuminances, calculated at 2'-6" (0.762 m) above the floor, for the entire space in 
the form of a 10 x 10 grid. The grid is scaled to fit the space, so the dimensions of each grid square (or 
rectangle) will vary depending on the dimensions of the scenario.  

Illuminance values are displayed for the date and time specified in the drop-down menu above the map. 
After selecting a date, the user needs to click on the refresh button (green arrow to the right of the date) to 
regenerate results for the new date. When hovering the mouse over a particular point in the grid, the 
illuminance value for that point is displayed. 

 

Figure 4-60.   Daylight illuminance maps 
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Since the daylight illuminance map calculation can considerably increase the length of the simulation 

(Energy Plus calculates values for each hour of the year), the illuminance maps are disabled by 

default to conserve simulation time. The illuminance map option can be enabled by accessing the 

Energy Plus tab under COMFEN > Preferences and selecting the “Calculate Illuminance” checkbox.   

 

Figure 4-61.   Enabling the daylight illuminance map calculation 

4.6.  Natural ventilation 

COMFEN allows the user to model the effect of natural ventilation in single-sided zones, i.e. zones with 
window openings on one elevation. When the natural ventilation option is selected, COMFEN will 
automatically model the scenario without mechanical cooling. It is thus not possible to model mixed-mode 
scenarios, i.e. scenarios where natural ventilation is used in combination with mechanical cooling. Before 
using the natural ventilation feature, it is recommended that the user first read this entire section and 
thoroughly familiarize themselves with the assumptions as well as the limitations of the natural ventilation 
module.  

 

 

Figure 4-62.  Sections showing two possible single-sided ventilation scenarios in COMFEN 



 4.  PROGRAM DESCRIPTION 

COMFEN 4.1 OCTOBER 2, 2012 4-59 

4.6.1. Assumptions 
 
There are several assumptions related to the geometry of the building, site, HVAC, and window implicit in 
the COMFEN natural ventilation model: 

1.   Window operation is entirely automated and optimized in terms of energy performance. It does not 
reflect how occupants actually operate windows in buildings. The operation sequence of the windows 
is described in more detail below. 

2.   Cooling is disabled for the whole year when natural ventilation is enabled. 

3.   The default effective open areas for predefined operable window types do not take into consideration 
the effect of insect screens on air flow. 

4.   The target space temperature for assessing thermal comfort is assumed to be the same as for a 
mechanically-cooled building, i.e. the upper threshold is equal to the cooling setpoint.  

5.   Wind speeds are calculated assuming that the space is located on the 4th floor of the building – 32. 8 
ft (10 m) above ground level, half-way between the scenario floor and ceiling.  

6.   The wind pressure coefficients used in the model were sourced from Chapter 16 of the 2004 ASHRAE 
Handbook of Fundamentals. 

7.   The zone is located on the 4th floor of a low-rise building (building height is less than three times its 
width), 10 m (32.8 ft) above ground level.  

8.   The building is assumed roughly square in plan and is located in a suburban area. 

4.6.2.  Window operation 

The operation of windows is controlled by the Energy Management System (EMS). Once open, window 
opening size is incrementally adjusted at defined timesteps in order to optimize energy performance while 
meeting basic occupant comfort requirements. The window control model implemented in COMFEN is a 
highly optimized model that is representative of an automated control system. 

The following points describe the window control sequence in more detail: 

1.   There is no schedule for window operation; windows can open at any hour if the criteria for opening 
windows are met.   

2.   Windows open whenever the indoor temperature exceeds 73.4 F (23 °C) Windows open whenever the 

indoor temperature exceeds 73.4 F (23 °C) provided that the outdoor air is cooler than the indoor air. 

Windows close when indoor temperature falls below 73.4 F (23 °C).  

3.   Once open, the window opening size may be adjusted to reduce thermal discomfort due to cool 
incoming air based on the temperature difference between inside and outside: 

< 41 F      (5°C)  windows are open at 100% 

41 – 59 F (5 - 15°C)  window opening size modulates between 100 and 30% 

> 59 F      (> 15°C)   windows are open at 30% 

This is illustrated in the figure below. The venting open factor represents the unobstructed portion of 
the open window area. 
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Figure 4-63.  Relationship between indoor outdoor temperature difference and window venting open factor 

 

4.   In order to prevent occupant discomfort due to drafts, window opening size is modulated to ensure 

that air speed at the window is below 1 m/s (3.3 ft/s). Air speed at the window is approximated by 

dividing the volume flow rate of air through each window by the window opening area. If the 

resulting  speed does not exceed 0.7 m/s (2.3 ft/s), windows remain fully open. If the speed is greater 

than 5 m/s (16.4 ft/s), windows close. At all other speeds the windows modulate between 100% and 

70% open. 

5.   It is assumed that ventilation through the windows is sufficient to meet space requirements for fresh 
air, so when windows are open, fans and economizer are off unless additional air for cooling is 
required. If windows are closed, fans and economizer operate as they would in a non-naturally-
ventilated scenario.  

6.   If windows are open yet additional outside air is required to cool the space (i.e. indoor temperature 
exceeds target for two consecutive timespteps), the fan turn ons, but only if the windows are open at 
100% (i.e. the difference between inddor and outdoor temperature is < 5°C).   

7.   Heating is allowed to run concurrently with natural ventilation, i.e. while the windows are open. 
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Figure 4-64.  Schematic of control sequence for window modulation based on indoor airspeed 

 

 

 

 

 

 

 

 

 

 



4.  PROGRAM DESCRIPTION 

4-62 OCTOBER 2, 2012 COMFEN 4.1  

4.6.3.  Limitations 

The COMFEN natural ventilation model has several limitations: 

1.   Mechanical cooling cannot be modeled in conjunction with natural ventilation.  

2.   The natural ventilation model does not account for the impact of exterior projections (overhangs and 
fins, open operable sashes of windows, etc.) on air flow. While the user is allowed to model shading 
systems and exterior projections (such as overhangs and fins) in conjunction with natural ventilation, 
they should be aware that COMFEN does not model their impact, so air flow may thus be 
overestimated. This also applies to the open operable sash of hinged windows (casement, awning, 
and hopper, etc.)  In order to ensure that air flow is not overestimated in scenarios with shading or 
exterior projections, the user may want to consider applying a factor to the window effective open 
area. Similarly, since the impact of insect screens is presently not factored in the effective open area of 
the different operating types, the user may want to again apply a factor to the EOA value to account 
for the insect screen.   

3.   Thermal and optical performance of partially- or fully-open windows is not fully accounted for in the 

energy model, i.e. the model does not adjust operable window solar and visible light transmittance at 

times when the window is open. As a result, the visible light transmittance and solar radiation 

transmitted by the window may be somewhat under- or overestimated at times. 

4.6.4.  Creating a scenario with natural ventilation 

In order to simulate a scenario with natural ventilation, the user has to first define which windows are 
operable and then check the natural ventilation checkbox under the scenario tab under the scenario edit 
screen.  

 

Figure 4-65.   Natural ventilation checkbox in the Scenario Edit view 

 

Adding an operable window to a scenario 

Operable windows can be defined in two ways:  

1. By adding a predefined operable window from the window library to the scenario.  

2. By editing a specific scenario window under the scenario edit window.  



 4.  PROGRAM DESCRIPTION 

COMFEN 4.1 OCTOBER 2, 2012 4-63 

To define an operable window in the window library, the user creates a window just as they would a fixed 
window and then specify an operable window type under the “operating type” pull-down under the window 
tab.  Options include hinged windows (casement, awning and hopper windows) and two sliding windows 
(horizontal slider and single-hung). The operating types are differentiated by effective open area and by the 
position of the effective opening with respect to the window (discussed in more detail below). Depending on 
the option selected, a different value is displayed in the effective open area dialog box below the “operating 
type” pull-down.   

 

Figure 4-66.   Creating of an operable window in the window library 

 

 

Figure 4-67.   Window Operating types 

Operating type can also be specified after the user creates a window in a scenario. For scenarios with punched 
windows, operating type is specified under the window edit dialog box where the user can select an option 
from the “operating type” pull-down.  To define the operating type for scenarios with glazed wall assemblies, 
left-click to highlight a lite and then right-click and select “set operating type” to pull up a dialog box with the 
list of operating types. See section 4.2.  Facade components and libraries for more information on creating 
operable windows for punched windows and glazed wall assemblies.  
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Figure 4-68.   Window Operating types 

Casement  Awning Hopper 

Double-hung  Horizontal slider  Single-hung  
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Window effective open area 

The effective open area (EOA) describes the portion of the opening area that is open (i.e. not obstructed by 
glazing and operable sashes of windows) and is calculated as follows: 

EOA = width eff x height eff / window area [%] 

where  

 window area = window height x window width and includes glazing and frame area 

 width eff   is the effective opening width (see diagram below) 

 height eff   is the effective opening height (see diagram below) 

The diagram below illustrates that the vertical projection of the operable sash unto the window delineates the 
edge of the open area. 

 

 

 

 

 

 

 

 

 

Figure 4-69.   Effective opening width and height 

 

The position of the opening is determined based on the position of the window and it is assumed that the 
lower left-hand corner of the opening coincides with the lower left-hand corner of the window when looking 
at the scenario in elevation view for all operating window types except hoppers, where the upper left-hand 
corner of the opening coincides with the upper left-hand corner of the window. 

NOTE: The width of the window frame is not considered when calculating the position of the opening – the corner of the 
opening always coincides with the outer corner of the frame regardless of the width of the frame. 

  

width eff 

    

opening 
height 

height eff 
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Figure 4-70.   Position of effective opening relative to window area (casement window) 

The width and height of the opening are determined in accordance with the operating window type, where 
one of the dimensions is held fixed. For example, for a casement window, changing the EOA affects the width 
of the window while the height of the opening is held fixed (equal to the height of the window). The diagram 
below illustrates how the value of EOA and the position of the opening varies with the different operating 
window types. The EOA values listed are the default values used in COMFEN however the user can override 
these by inputting a custom EOA value under the window edit screen.  
 

 

Figure 4-71.   Default effective open areas for different window types 

Extent of opening 

Lower left-hand corner of opening coincides 

with lower left-hand corner of window 

EOA = 

90% 
EOA = 

40% 

Casement       EOA = 90%                Awning     EOA = 75%                     Hopper     EOA = 45% 

Single-hung     EOA = 45%           Horiz. slider     EOA = 45%                  Fixed                   EOA = 0% 
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4.7.  Cost calculation 

A simple cost model is incorporated into COMFEN to help the user compare the economic feasibility 

of different scenarios. Basic cost data obtained from R.S. Means and ASHRAE documentation is 

provided for the following components: 

 Glass layers 

 Gases 

 Frames 

 Glazing systems 

 Shading systems 

 Window systems 

 HVAC system 

 Lighting and lighting controls 

Assumptions for specific systems and components are discussed below. 

4.7.1.  Overview 

1. All costs listed throughout the COMFEN interface include a material and labor cost, i.e. the cost of all 
components and systems is the installed cost and includes a 30% markup to account for contractor and 
subcontractor costs. This applies to both total costs listed in the scenario cost tab as well as component 
costs listed in the libraries.  

2. After total project cost has been calculated, it is multiplied by a location-specific adjustment factor to 
account for variation in construction costs. The resulting value is called the “Adjusted cost.”  Since 
this adjustment is location-specific, none of the component costs in the libraries are adjusted. This 
adjustment is made under the scenario’s cost tab. 

3. Costs for glass, gas, frame, glazing, and shading are listed per unit window area, i.e. area of the 
window rough opening. Lighting and HVAC costs are listed per unit floor area. 

4. Costs for opaque wall construction and exterior projections (overhangs and fins) are not available.  

The user can override the cost of most components by inputting their own value. Since the current 

cost data is only approximate, it is recommended that the user input their own data whenever 

possible. The cost toggle icon in the menu bar – , determines if the total scenario cost is displayed 

in the upper left corner of the scenario view. 

 

Figure 4-72.  Cost toggle icon 
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4.7.2.  Component cost assumptions 

Glass layer cost 

NOTE: COMFEN glass layer costs assume 6 mm glass and do not account for varying thicknesses of glass. 

Present glass layer unit costs, C glass  ($/ft2 window), are approximate and provided in terms of a 

baseline glass (6 mm clear uncoated glass) cost – 10.70 $/ft2 (115.17 $/m2). An incremental cost is 

added to the baseline glass cost for to account for additional cost premiums (based on the data 

provided in the table below): 

C glass = C glass base  + C glass inc = 10.70 $/ft2  + C glass inc  [$/ft2 window area] 

 

Table 4-3. Glass layer incremental costs 

Baseline glass (6mm clear uncoated glass) cost is 5.35 $/ft2 (57.59 $/m2).  To calculate total glass cost, add 
incremental cost to baseline glass cost. 

  Glass characteristic  Notes Incremental 
cost  ($/ft2 
of window) 

Incremental 
cost  ($/m2 
of window) 

1 Clear  +$0.00  +$0.00  

2 Tinted  Green, bronze, gray +$0.82  +$8.83  

3 High-performance tint Green, blue +$1.92  +$20.67  

4 Reflective Pyrolitic or sputter coating on 
clear glass 

+$4.11  +$44.24  

5 Reflective on Tint Pyrolitic or sputter coating, all 
tints 

+$6.31  +$67.92  

6 Low-E Pyrolitic or sputter coating on 
clear glass  

+$1.10  +$11.84  

7 Tint + low-e All tints, all low-e types +$2.74  +$29.49  

8 Sunbelt low-e Sunbelt Low-e +$1.92  +$20.67  

9 Suspended film Mylar film with low-e coating +$10.97  +$118.08  

10 Double suspended film Double film and special edge 
treatment 

+$21.95 +$236.57 

 

The default glass cost can be modified by checking the override box in the Edit glass dialog box and 

inputting a custom value in the field. The “Type” drop-down determines the incremental cost (or 

premium) added to the base glass cost based on the values listed in the table. 
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Figure 4-73.   Edit glass dialog box, whre the default glass cost can be overridden 
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Gas layer cost 

Gas costs are listed per unit window area. The gas costs assume 2’-6” by 4’-0” glazing and the gap thicknesses 
listed in the table below. 

NOTE: Cost per unit area values are fixed, i.e. they are not adjusted depending on gap thickness. 

Table 4-4. Gas layer widths 

ID Gas Gap width 

(in.) 

Gap width 

(mm) 

$/ft
2
 $/m

2
 

1 Air 1/2" 12.70 $0.00 $0.00 

2 Argon 1/2" 12.70 $1.00 $10.78 

3 Krypton 5/16" 7.94 $5.50 $59.17 

4 Xenon 1/4" 6.35 $21.83 $234.92 

6 Air (5%) / Argon (95%) Mix 1/2" 12.70 $0.95 $10.24 

7 Air (12%) / Argon (22%) / Krypton (66%) Mix 5/16” 7.94 $3.77 $40.53 

8 Air (5%) / Krypton (95%) Mix 5/16” 7.94 $5.22 $56.21 

9 Air (10%) / Argon (90%) Mix 1/2" 12.70 $0.90 $9.70 

 

 

Figure 4-74.   Edit gas dialog box, where the default gas cost can be overridden. 
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Glazing system cost 

Glazing system unit cost (in $/ft2 window area) is calculated based on glass layer, gas layer and 

fabrication cost:  

C glz sys = (C glass 1 + … + C glass n) + (C gas 1 + … + C gas n) + fabrication cost  [$/ft2 window area] 

Where  

C glass 1 + … + C glass n  is the combined cost of individual glass layers [$/ft2 window area] 

C gas 1 + … + C gas n  is the combined cost of individual gas layers [$/ft2 window area] 

Fabrication cost is the additional cost (per unit area of window area) associated with the making of an 

insulated glazing system; it includes the cost of an aluminum spacer and fabrication: 

Single glazing = $0/ft2  

Double glazing = $5.49/ft2 

More than two glass layers = $2.74/ ft2 for each additional glazing layer 

 

 

Figure 4-75.   Glazing system edit screen, where the calculated cost can be overridden. 
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Frame cost 

Similar to other window component cost data, frame cost, C frame, is listed per unit window area, i.e. 

area of the window rough opening. User should note that frame costs are approximate – costs do not 

change if area of framing is increased since the framing cost is per unit window area, not frame area.  

 

Figure 4-76.   Frame Library List View 

The user can override the cost of framing by checking the cost override checkbox under the Edit frame 

dialog box and inputting a custom value. 

 

Figure 4-77.   Frame Library Detailed View, where the default cost can be overridden. 
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Spandrel cost 

Glazed wall assembly spandrel costs are approximated due to lack of adequate cost data. One of two fixed 
numbers – $80/ft2 and $50/ft2 is assumed for spandrels with and without glazing, respectively. These costs 
assume a “standard” spandrel construction: exterior cladding, air space, metal backpan, 4” of insulation and 
interior finish. The cost for the spandrel is not adjusted if any of these layers change.  

 

Figure 4-78.   Spandrel Library List View 

 

Figure 4-79.   Spandrel Library Detailed View where the default cost can be overridden 
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Shading system cost  

Shading system cost, C shad  sys ($/ft2 window area) is calculated based on shading system type 

(venetian blind, roller shade and screen), shading position (interior, exterior, inbetween glazing) and 

presence of automated shading systems controls. The cost of the shading system is calculated as 

follows: 

C shad sys  = C shad device + C control   [$/ft2 window area] 

Where 

 C shad device  shading device cost [$/ft2 window area] 

 C control   shading system control cost [$/ft2 window area] 

Venetian blind device costs presently do not vary by slat depth – it is assumed that interior blinds 

have a 1”-deep slat while exterior blinds have a 3”-deep slat. Exterior metal screen cost represents the 

cost of a mid-range metal architectural screen. 

The user can override the shading device and/or control cost under the shading system edit screen.   

 

Figure 4-80.   Shading System Library List View 
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Figure 4-81.   Shading System Detailed View where the default costs can be overridden. 
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Window cost  

Window cost  is the sum of the frame, glazing and shading system costs. The cost of the window is 

calculated as follows: 

C win = A win  x (C frame  + C shad sys + C glz) [$/window] 

Where  

A win   Area of rough opening (includes frame area) [ft2] 

C frame    Unit frame cost [$/ft2 window area] 

C shad sys  Unit shading system cost [$/ft2 window area] 

C glz  Unit glazing system cost [$/ft2 window area] 

 

Figure 4-82.   Window Detailed View, which can be used to override the calculated cost value. 
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HVAC cost 

HVAC system costs are determined based on heating and cooling equipment size. Thus, in order to 

obtain HVAC system costs, the user must first calculate the scenario so that the program can 

determine the equipment sizing. Equipment costs are then calculated by multiplying the following 

default unit costs by the equipment size: 

 Heating equipment:  20.80 $/kBtu-hr (70.97 $/kW) 

 Cooling equipment:  939.73 $/ton (267.27 $/kW) 

Similar to other default cost values in COMFEN, the default HVAC equipment costs can be overriden 

by the user under the cost tab in the Project Properties dialog box. 

 

Figure 4-83.   The default HVAC equipment costs can be overridden in the Project Properties Cost tab. 
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Lighting cost 

Cost data for the lighting system is calculated as follows: 

 lighting power density, cost per lighting load specified by the user under the scenario tab: 

C light sys = A zone x (C fixture + C control) [$] 

Where  

C fixture   Fixture cost per unit floor area [W/ft2] 

C control  Control cost per unit floor area [W/ft2] 

A zone    Scenario floor area [ft2] 

Lighting fixture and control costs can be overriden under the cost tab in the Project Properties dialog 

box.  

 

Figure 4-84.   The default Lighting Fixture and Lighting Control costs can be overridden in the  
Project Properties Cost tab. 
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4.7.3.  Cost Results 

Under the Comparison > Cost tab there are three results tabs: 

 First Cost 

 Energy Cost 

 Simple Payback 

The default COMFEN database (comfen.sqlite) has a Cost Example Project, where three scenarios are defined: 

 # 118 -- Single Clear (SHGC = 0.818, Tvis = 0.884) 

 # 119 -- Double Clear Low E (Low SHGC - 0.288, High Tvis - 0.622) 

 # 120 -- Double Clear Low E with continuous lighting controls 

First Cost  

The first cost is the initial cost of construction. In the case of COMFEN it is the installed cost of the HVAC 
equipment, the lighting fixtures and controls, windows and shading (exterior projections and opaque wall 
construction are not included in these costs at present), adjusted by location to account for the cost of 
construction.  In order to account for variation in construction costs in different locations, the first cost 
includes an adjustment factor for the project location. The adjustment factors are defined in the Location 
Library. 

The project first cost is calculated as follows: 

FC Adj = Adj factor x (FC Light + FC Win + FC HVAC) 

Where  

 Adj factor – location-specific construction cost adjustment factor 

 FC Light  -  first cost of lighting fixtures and lighting controls ($) 

 FC Win  -  first cost of windows and shading (excluding exterior projections) ($) 

 FC  HVAC - first cost of heating, cooling and ventilation equipment ($) 

 

The figure below shows the Comparison > Cost > First Cost results for the Cost Example project.  

The first cost of Scenario ID # 119 includes substituting high performance glazing for the single clear in the 
Base Case. The first cost of Scenario ID # 120 includes the cost of both the high performance glazing and 
continuous dimming lighting controls (based on daylighting levels in the space). The cost of the lighting 
controls is set to the default value of $10/sf, which is a cost potentially appropriate for a retrofit situation 
where rewiring is needed. 
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Figure 4-85.   Two different first costs for the scenario with lighting controls – the top is based on $10/sf (potential cost 
for retrofit rewiring) and the bottom is based on $2/sf (potential cost for new construction). 
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Energy cost 

Annual energy cost in COMFEN is the sum of the annual cost of gas and electricity consumed by the scenario. 
Due to differences in the cost of natural resources, the electric and gas rates vary by location.  These utility 
rates are stored in the location library. 

The project energy cost is calculated as follows: 

EC = r elec x Eelec + r gas x Egas 

Where  

 EC – annual energy cost ($) 

relec – electricity rate ($/kWh) 

rgas – gas rate ($/m3 or $$/therm) 

 Eelec – annual electricity consumption (MJ or kBtu) 

Egas – annual gas consumption (MJ or kBtu) 

 

The figures below show the Energy Cost for the three scenarios in the Cost Example project. Note that the 
energy cost for the third scenario reflects reductions in cooling and fan energy due to the reduced lighting 
energy use because of the lighting controls.  

 

Figure 4-86.   The Energy Cost tab for the three scenarios.  
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Simple Payback 

Energy-efficiency strategies in buildings are often evaluated in terms of their economic feasibility. One such 
measure is the simple payback – the amount of time (usually in years) required to recover the initial project 
cost in an opportunity. For example, simple payback can be used to calculate the time it will take for cost 
savings accrued during the building operation phase to offset the increased capital cost associated with a 
specific design strategy or set of design strategies, such as better-performing windows or lighting controls. 
While increased investment in advanced facade design strategies may yield savings in other ways, including 
higher worker productivity and improved building market value, the payback calculation in COMFEN only 
takes into consideration the annual energy savings of the scenario.  

The payback is calculated as follows: 

Payback (years) = (FC Case 1 – FC BC ) /(EC Case 1 – EC BC )  

Where 

FC Case 1 – first cost of scenario  

FC BC – first cost of base case (reference) scenario 

EC Case 1 – energy cost of scenario 

EC BC – energy cost of base case (reference) scenario 

 

The figure below shows two different payback results, the top being for the case where the lighting control 
costs were set to $10/sf (the program default) for a retrofit situation and the second for the case where the 
lighting control costs were overridden and set to $2/sf for a new construction situation. 

The lighting control costs can be overridden in the Project Properties > Cost tab > Lighting Controls Cost 
section.  

 

Figure 4-87.   The default lighting controls cost can be overridden in the Project Properties > Cost tab > Lighting 
Controls Cost section. 
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Figure 4-88.   Two different Simple Payback resutls for the scenario with lighting controls – the top is based on $10/sf 
(potential cost for retrofit rewiring) and the bottom is based on $2/sf (potential cost for new construction). 
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4.8.  Results 

4.8.1.  Detailed reports 

In addition to the many graphic results that can be obtained from COMFEN, the detailed report files 
generated by the Energy Plus simulation engine are also stored, and can be used to delve even deeper into the 
scenario results and create custom graphs and data sets. 

The COMFEN results folder (LBNL\COMFEN4\Results) contains the following Energy Plus files: 

 scen_ID.idf – Energy Plus input file 

 scen_ID_binned_eplus_output_data.csv 

 scen_ID_eplusmap.csv 

 scen_ID_eplusout.csv – hourly Energy Plus simulation output 

 scen_ID_eplusTbl_Table.csv – Energy Plus output results summary  

The scen_ID_ eplusout.csv and scen_ID_ eplusTbl_Table.csv files provide a wealth of additional information 
about scenario results which may be of interest to the more advanced COMFEN user who would like to 
analyze the result in greater detail.  

Additional results can be generated by editing the user_report_variables.xml file in the 
LBNL\COMFEN4\settings folder. The results will be compiled in a file called scen_ID_user_report.csv. See 
below. 

scen_ID_eplusTbl_Table.csv  

The scen_ID_ eplusTbl_Table.csv file includes a number of summary reports, some of which have been listed 
below: 

 HVACSizingSummary – Heating and cooling equipment size (user design load column) 

Additional reports: editing the user_report_variables.xml file 

An additional file, scen_ID_user_report.csv, can be generated by editing the user_report_variables.xml file in the 
LBNL\COMFEN4\settings folder and specifying additional variables for which they would like detailed 
results to be generated. By default, none of these variables are selected so no reports are generated. The user 
can specify reports they want generated by enclosing variables of interest with the following markers: 

<!--  denotes beginning of section 

--> denotes end of section 

In the following example, which shows only a few of the variables in the .xml file, hourly “Direct 

Solar”and "Solar Azimuth Angle" reports will be generated. 

<variable keyValue="*" nameInReport="Diffuse Solar" nameInRVI="Diffuse Solar" /> 

<!-- <variable keyValue="*" nameInReport="Direct Solar" nameInRVI="Direct Solar" /> 

<variable keyValue="*" nameInReport="Solar Azimuth Angle" nameInRVI="Solar Azimuth Angle" /> 

<variable keyValue="*" nameInReport="Solar Altitude Angle" nameInRVI="Solar Altitude Angle" /> --

> 

<variable keyValue="*" nameInReport="Solar Hour Angle" nameInRVI="Solar Hour Angle" /> 
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NOTE: It is a good idea to create a copy of this file prior to editing in order to keep the original with 

complete list of variables. A more advanced text editor (e.g. TextPad) is recommended for editing the 

file because lack of paragraph formatting in Notepad makes it difficult to view the list of report 

variables.  
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4.9.  Appendix 

General simulation parameters such as schedule, building type, etc. are written to the in.idf file located in the 
COMFEN Energy Plus Input folder. It is recommended that the user interested in understanding the 
calculation assumptions review this file and reference the Energy Plus Input/Output Reference 
documentation (available for download from the Energy Plus website) for an explanation of each parameter. 

4.9.1.  Occupancy, lighting and equipment loads  

Information on occupancy, lighting and equipment loads can be found in the in.idf file, a section of which is 
included below. The Number of People, LightingLevel, EquipmentLevel inputs correspond to values defined 
by the user. Occupancy, lighting and equipment load schedules vary by building type. 
 

People, 

    COMFENZone People 1,     !- Name 

    COMFENZone,              ! Zone Name 

    OCC-SCHED,                 ! People Schedule Name 

    People,                  ! Number of people calculation method 

    0.96,                !- Number of People 

    ,                        !- People per Zone Floor Area {person/m2} 

    ,                        !- Zone Floor Area per Person {m2/person} 

    0.3,                     !- Fraction Radiant 

    ,                        !- Sensible Heat Fraction 

    ACTIVITY-SCHED,          !- Activity Level Schedule Name 

    ,                        !- Carbon Dioxide Generation Rate {m3/s-W} 

    ,                        !- Enable ASHRAE 55 Comfort Warnings 

    zoneaveraged,            !- Mean Radiant Temperature Calculation Type 

    ,                        !- Surface Name/Angle Factor List Name 

    WORK_EFF-SCHED,            !- Work Efficiency Schedule Name 

    CLOTHING-SCHED,            !- Clothing Insulation Schedule Name 

    AIR_VELO-SCHED,            !- Air Velocity Schedule Name 

    Fanger;                  !- Thermal Comfort Model 1 Type 

  

Lights, 

    COMFENZone Lights,       !- Name 

    COMFENZone,              !- Zone Name 

    LIGHT-SCHED,               !- Schedule Name 

    LightingLevel,           !- Design Level Calculation Method 

     500.820068359,           !- Lighting Level {W} 

    ,                        !- Watts per Zone Floor Area {W/m2} 

    ,                        !- Watts per Person {W/person} 

    0.,                      !- Return Air Fraction 

    0.7,                    !- Fraction Radiant 

    0.2,                     !- Fraction Visible 

    1.,                      !- Fraction Replaceable 

    GeneralLights;           !- End-Use Subcategory 

  

  ElectricEquipment, 

    COMFENZone ElecEq,       !- Name 

    COMFENZone,              !- Zone Name 

    EQUIP-SCHED,               !- Schedule Name 

    EquipmentLevel,          !- Design Level Calculation Method 

     300.492034912,  ! Design Level {W} 

    ,                        !- Watts per Zone Floor Area {W/m2} 

    ,                        !- Watts per Person {W/person} 

    0.,                      !- Fraction Latent 

    0.5,                     !- Fraction Radiant 

    0.,                      !- Fraction Lost 

    0;                       !- End-Use Subcategory 

http://apps1.eere.energy.gov/buildings/energyplus/energyplus_documentation.cfm
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4.9.2.  Schedules and setpoints 

The following building types can be presently modeled in COMFEN. 

 Office (office space) 
 Mid-rise residential  
 Hotel (guest room) 
 Retail (point of sale) 
 School (classroom) 

This section includes heating and cooling setpoints and schedules (occupancy, lighting, electrical equipment 
and infiltration) by building/space type.  

 

Office (office space) 

Cooling and heating setpoints, °C                               

CLG-SCHED   

Temperature,              

  Through: 12/31,           

  For: Weekdays SummerDesignDay 

  Until: 06:00,             

  26.7,                     

  Until: 22:00,             

  24.0,                     

  Until: 24:00,             

  26.7,                     

  For: Saturday,            

  Until: 06:00,             

  26.7,                     

  Until: 18:00,             

  24.0,                     

  Until: 24:00,             

  26.7,                     

  For: AllOtherDays,        

  Until: 24:00,             

  26.7                     

 

HTG-SCHED,   

  Temperature,              

  Through: 12/31,           

  For: Weekdays,            

  Until: 06:00,             

  15.6,                     

  Until: 22:00,             

  21.0,                     

  Until: 24:00,             

  15.6,                     

  For: Saturday,            

  Until: 06:00,             

  15.6,                     

  Until: 18:00,             

  21.0,                     

  Until: 24:00,             

  15.6,                     

  For: WinterDesignDay,     

  Until: 24:00,             

  21.0,                     

  For: AllOtherDays,        

  Until: 24:00,             

  15.6 
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Infiltration

Time

Infiltr. 

(week

day)

Infiltr. 

(Sat.)

Infiltr. 

(all 

other 

days)

24:00 – 

6:00
1 1 1

6:00 – 

18:00
0.25 0.25 1

18:00 – 

22:00
0.25 1 1

22:00 – 

24:00
1 1 1

 

Occupancy, Lighting and Equipment

Time

Occ. 

(week

day)

Occ. 

(Sat.)

Occ. 

(all 

other 

days)

Light. 

(week

day)

Light. 

(Sat.)

Light. 

(all 

other 

days)

Equip. 

(week

day)

Equip. 

(Sat.)

Equip. 

(all 

other 

days)

24:00 – 

5:00
0 0 0 0.05 0.05 0.05 0.4 0.3 0.3

5:00 – 

6:00
0 0 0 0.1 0.05 0.05 0.4 0.3 0.3

6:00 – 

7:00
0.1 0.1 0 0.1 0.01 0.05 0.4 0.4 0.3

7:00 – 

8:00
0.2 0.1 0 0.3 0.01 0.05 0.4 0.4 0.3

8:00 – 

12:00
0.95 0.5 0 0.9 0.5 0.05 0.9 0.5 0.3

12:00 – 

13:00
0.5 0.5 0 0.9 0.5 0.05 0.8 0.5 0.3

13:00 – 

14:00
0.95 0.5 0 0.9 0.5 0.05 0.9 0.5 0.3

14:00 – 

17:00
0.95 0.1 0 0.9 0.15 0.05 0.9 0.35 0.3

17:00 – 

18:00
0.7 0 0 0.7 0.05 0.05 0.8 0.3 0.3

18:00 – 

20:00
0.4 0 0 0.5 0.05 0.05 0.6 0.3 0.3

20:00 – 

22:00
0.1 0 0 0.3 0.05 0.05 0.5 0.3 0.3

22:00 – 

24:00
0.05 0 0 0.1 0.05 0.05 0.4 0.3 0.3
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Occ. Light. Equip. Infiltr. Occ. Light. Equip. Infiltr.

24:00 – 

6:00
0 1 1 1 0 0 0 1

6:00 – 

18:00
1 1 1 0.25 0 0 0 0.25

18:00 – 

22:00
1 1 1 0.25 0 0 0 1

22:00 – 

24:00
0.05 1 1 1 0 0 0 1

Winter design daySummer design day

Time

 

Mid-rise residential (apartment)  

Cooling and heating setpoints, °C 

CLG-SCHED  

 Temperature,              

  THROUGH: 12/31,           

  FOR:AllDays,              

  UNTIL: 24:00  

  23.9  

                    

HTG-SCHED,   

  Temperature,              

  THROUGH: 12/31,           

  FOR:AllDays,              

  UNTIL: 24:00,             

  21.1  
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Infiltration

All times 1.0

Occupancy, Lighting and Equipment

All days

Time Occ. Light. Equip. Time Occ. Light. Equip. 

24:00 – 

1:00
1.00 0.07 0.45

12:00 – 

13:00
0.25 0.12 0.69

1:00 – 

2:00
1.00 0.07 0.41

13:00 – 

14:00
0.25 0.12 0.66

2:00 – 

3:00
1.00 0.07 0.39

14:00 – 

15:00
0.25 0.12 0.65

3:00 – 

4:00
1.00 0.07 0.39

15:00 – 

16:00
0.25 0.21 0.68

4:00 – 

5:00
1.00 0.19 0.38

16:00 – 

17:00
0.30 0.44 0.80

5:00 – 

6:00
1.00 0.39 0.43

17:00 – 

18:00
0.52 0.62 1.00

6:00 – 

7:00
1.00 0.44 0.54

18:00 – 

19:00
0.87 0.83 1.00

7:00 – 

8:00
0.85 0.39 0.65

19:00 – 

20:00
0.87 0.99 0.93

8:00 – 

9:00
0.39 0.17 0.66

20:00 – 

21:00
0.87 1.00 0.89

9:00 – 

10:00
0.25 0.12 0.67

21:00 – 

22:00
1.00 0.69 0.85

10:00 – 

11:00
0.25 0.12 0.69

22:00 – 

23:00
1.00 0.38 0.71

11:00 – 

12:00
0.25 0.12 0.70

23:00 – 

24:00
1.00 0.16 0.58

 

 

Hotel (guest room) 

Cooling and heating setpoints, °C                               

CLG-SCHED,     

  Temperature,              

  Through: 12/31,           

  For: AllDays,             

  Until: 24:00,             

  24                   

 

HTG-SCHED,   

  Temperature,              

  Through: 12/31,           

  For: AllDays,             

  Until: 24:00,             

  21                     

Infiltration

All times 0.25  
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Occupancy, Lighting and Equipment

Time
Occ. 

(weekday)

Occ. (all 

other days)

Light. 

(weekday)

Light. (all 

other days)

Equip. 

(weekday)

Equip. (all 

other days)

24:00 – 

1:00
0.65 0.65 0.22 0.26 0.2 0.3

1:00 – 

2:00
0.65 0.65 0.17 0.26 0.2 0.3

2:00 – 

5:00
0.65 0.65 0.11 0.11 0.2 0.3

5:00 – 

6:00
0.65 0.65 0.22 0.11 0.2 0.3

6:00 – 

7:00
0.5 0.5 0.44 0.41 0.62 0.3

7:00 – 

8:00
0.28 0.34 0.56 0.41 0.9 0.62

8:00 – 

9:00
0.28 0.34 0.44 0.56 0.43 0.9

9:00 – 

10:00
0.13 0.2 0.44 0.56 0.43 0.62

10:00 – 

11:00
0.13 0.2 0.28 0.41 0.26 0.29

11:00 – 

12:00
0.13 0.2 0.28 0.33 0.26 0.29

12:00 – 

13:00
0.13 0.2 0.28 0.33 0.26 0.29

14:00 – 

15:00
0.13 0.2 0.28 0.33 0.26 0.29

15:00 – 

16:00
0.2 0.2 0.28 0.33 0.26 0.29

16:00 – 

17:00
0.35 0.2 0.28 0.33 0.26 0.29

17:00 – 

18:00
0.35 0.34 0.28 0.33 0.51 0.43

18:00 – 

19:00
0.35 0.35 0.67 0.85 0.51 0.51

19:00 – 

20:00
0.5 0.65 0.89 1 0.49 0.49

20:00 – 

21:00
0.5 0.65 1 1 0.66 0.66

21:00 – 

22:00
0.65 0.5 0.89 1 0.7 0.7

22:00 – 

23:00
0.65 0.5 0.67 0.85 0.35 0.35

23:00 – 

24:00
0.65 0.5 0.33 0.41 0.2 0.2

 

Occ. Light. Equip. Occ. Light. Equip.

All day 1 1 1 0 0 0

Time
Winter design daySummer design day
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Retail (point-of-sale) 

Cooling and heating setpoints, °C                               

CLG-SCHED,   

  Temperature,              

  Through: 12/31,           

  For: Weekdays SummerDesig 

  Until: 06:00,             

  30.0,                     

  Until: 21:00,             

  24.0,                     

  Until: 24:00,             

  30.0,                     

  For: Saturday,            

  Until: 06:00,             

  30.0,                     

  Until: 22:00,             

  24.0,                     

  Until: 24:00,             

  30.0,                     

  For WinterDesignDay,      

  Until: 24:00,             

  30.0,                     

  For: Sunday Holidays AllO 

  Until: 8:00,              

  30.0,                     

  Until: 19:00,             

  24.0,                     

  Until: 24:00,             

  30.0   

   

HTG-SCHED,   

  Temperature,              

  Through: 12/31,           

  For: Weekdays,   
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  Until: 06:00,             

  15.6,                     

  Until: 21:00,             

  21.0,                     

  Until: 24:00,             

  15.6,                     

  For SummerDesignDay,      

  Until: 24:00,             

  15.6,                     

  For WinterDesignDay,      

  Until: 24:00,             

  21.0,                     

  For: Saturday,            

  Until: 06:00,             

  15.6,                     

  Until: 22:00,             

  21.0,                     

  Until: 24:00,             

  15.6,                     

  For: Sunday Holidays All 

  Until:  8:00,             

  15.6,                     

  Until: 19:00,             

  21.,                      

  Until: 24:00,             

     15.6                    
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Infiltration

Time

Infiltr. 

(week

day)

Infiltr. 

(Sat.)

Infiltr. 

(all 

other 

days)

24:00 – 

6:00
1 1 1

6:00 – 

8:00
0.5 0.5 1

8:00 – 

17:00
0.5 0.5 0.5

17:00 – 

21:00
0.5 0.5 1

21:00 – 

22:00
1 0.5 1

22:00 – 

24:00
1 1 1

 

Time

Occ. 

(weekda

y)

Occ. 

(Sat.)

Occ. (all 

other 

days)

Light. 

(weekda

y)

Light. 

(Sat.)

Light. 

(all 

other 

days)

Equip. 

(weekda

y)

Equip. 

(Sat.)

Equip. 

(all 

other 

days)

24:00 – 

6:00
0 0 0 0.05 0.05 0.05 0.2 0.15 0.15

6:00 – 

7:00
0 0 0 0.05 0.05 0.05 0.2 0.15 0.15

7:00 – 

8:00
0.1 0.1 0 0.2 0.1 0.05 0.4 0.3 0.15

8:00 – 

9:00
0.2 0.2 0 0.5 0.3 0.1 0.7 0.5 0.3

9:00 – 

10:00
0.5 0.5 0.1 0.9 0.6 0.1 0.9 0.8 0.3

10:00 – 

11:00
0.5 0.6 0.2 0.9 0.9 0.4 0.9 0.9 0.6

11:00 – 

12:00
0.7 0.8 0.2 0.9 0.9 0.4 0.9 0.9 0.6

12:00 – 

17:00
0.7 0.8 0.4 0.9 0.9 0.6 0.9 0.9 0.8

17:00 – 

18:00
0.5 0.6 0.2 0.9 0.9 0.4 0.9 0.9 0.6

18:00 – 

19:00
0.5 0.2 0.1 0.6 0.5 0.2 0.8 0.7 0.4

19:00 – 

20:00
0.3 0.2 0 0.6 0.3 0.05 0.8 0.5 0.15

20:00 – 

21:00
0.3 0.2 0 0.5 0.3 0.05 0.7 0.5 0.15

21:00 – 

22:00
0 0.1 0 0.2 0.1 0.05 0.4 0.3 0.15

22:00 – 

24:00
0 0 0 0.05 0.05 0.05 0.2 0.15 0.15
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Occ. Light. Equip. Infiltr. Occ. Light. Equip. Infiltr.

24:00 – 

6:00
1 1 1 1 1 0 0 1

6:00 – 

21:00
1 1 1 0.5 1 0 0 1

21:00 – 

24:00
1 1 1 1 1 0 0 1

Time
Summer design day Winter design day

 

School (classroom) 

Cooling and heating setpoints, °C                               

CLG-SCHED,   

  Temperature, 

  Through: 6/30, 

  For: SummerDesignDay, 

  Until: 24:00, 24, 

  For: WeekEnds Holidays WinterDesignDay, 

  Until: 24:00, 27, 

  For: AllOtherDays, 

  Until: 06:00, 27, 

  Until: 21:00, 24, 

  Until: 24:00, 27, 

  Through: 9/1, 

  For: SummerDesignDay, 

  Until: 24:00, 24, 

  For: WeekEnds Holidays WinterDesignDay, 

  Until: 24:00, 27, 

  For: AllOtherDays, 

  Until: 07:00, 27, 

  Until: 18:00, 24, 

  Until: 24:00, 27, 

  Through: 12/31, 

  For: SummerDesignDay, 

  Until: 24:00, 24, 

  For: WeekEnds Holidays WinterDesignDay, 

  Until: 24:00, 27, 

  For: AllOtherDays, 

  Until: 06:00, 27, 

  Until: 21:00, 24, 

  Until: 24:00, 27; 

 

HTG-SCHED,   

  Temperature, 

  Through: 6/30, 

  For: WinterDesignDay, 

  Until: 24:00, 21, 

  For: WeekEnds Holidays SummerDesignDay, 

  Until: 24:00, 16, 

  For: AllOtherDays, 

  Until: 06:00, 16, 

  Until: 21:00, 21, 

  Until: 24:00, 16, 

  Through: 9/1, 

  For: WinterDesignDay, 

  Until: 24:00, 21, 

  For: WeekEnds Holidays SummerDesignDay, 

  Until: 24:00, 16, 

  For: AllOtherDays, 

  Until: 07:00, 16, 

  Until: 18:00, 21, 

  Until: 24:00, 16, 

  Through: 12/31, 
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  For: WinterDesignDay, 

  Until: 24:00, 21, 

  For: WeekEnds Holidays SummerDesignDay, 

  Until: 24:00, 16, 

  For: AllOtherDays, 

  Until: 06:00, 16, 

  Until: 21:00, 21, 

  Until: 24:00, 16; 

 

Infiltration, all days: 

All days, 24:00-7:00 1

All days, 7:00-21:00 0.5

All days, 21:00-24:00 1  

Occupancy, Lighting and Equipment

Weekdays

Time

Occ. 

9/2- 

6/30

Occ. 

7/1 - 

9/1

Light. 

9/2- 

6/30

Light. 

7/1 - 

9/1

Equip. 

9/2- 

6/30

Equip. 

7/1 - 

9/1

24:00 – 

7:00
0 0 0.1773 0.1773 0.35 0.25

7:00 – 

8:00
0 0 0.9 0.1773 0.35 0.25

8:00 – 

9:00
0.7 0.15 0.9 0.5 0.95 0.5

9:00 – 

10:00
0.7 0.15 0.9 0.5 0.95 0.5

10:00 – 

11:00
0.7 0.15 0.9 0.5 0.95 0.5

11:00 – 

12:00
0.7 0.15 0.9 0.5 0.95 0.5

12:00 – 

16:00
0.7 0.15 0.9 0.5 0.95 0.5

16:00 – 

17:00
0.15 0.15 0.9 0.5 0.95 0.5

17:00 – 

20:00
0.15 0.15 0.9 0.5 0.35 0.25

20:00 – 

21:00
0.15 0.15 0.9 0.1773 0.35 0.25

21:00 – 

24:00
0 0 0.1773 0.1773 0.35 0.25

 

Weekends and holidays

Time Occ. Light. 

Equip. 

9/2- 

6/30

Equip. 

7/1 - 

9/1

All day 0 0.1773 0.35 0.25  
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4.9.3.  Lighting control  

The lighting control logic is embedded in the program as illustrated in the diagram below: 

 

 

Figure 4-89.  Plan view of daylighting control sensors. 

 

 Daylight Illuminance:  The daylight illuminance setpoint is currently set at 50 footcandles. 

 Zone Depth:  A primary daylight zone depth is calculated as the minimum of a) the room depth, b) 
1.5 times the facade wall height, and c) 15 feet. 

 Sensor # 1:  Daylight sensor #1 is positioned 2/3 of the primary daylight zone depth from facade 
wall (centered in the width of the facade zone) and positioned at desk height: 2'-6" (0.76 m) above 
the floor. Sensor #1 controls a fraction of the facade zone lights equal to the primary daylight zone 
depth divided by the facade zone depth. 

 Sensor # 2:  Any remaining depth in the facade zone is considered a secondary daylight zone.  
Sensor #2 is positioned halfway between the primary daylight zone depth and the "back wall." 
Similar to sensor #1, the sensor is centered in the width of the facade zone and positioned at desk 
height: 2'-6" (0.76 m) above the floor. Sensor #2, if used, controls the remaining fraction of lights. 

 

The Lighting Control pulldown under the scenario edit screen contains three choices for lighting 

controls:  

 None: No lighting controls based on daylight levels. 

 Continuous:  Continuous lighting controls based on daylight levels.  

Front of facade  

Sensor # 1  

+  Centered between 
the left and right 
walls  

Positioned 2/3 of zone depth 
from front of facade 

Sensor # 2  

Centered in 
the zone 

+  

Daylighting Zone # 1 depth 
– the minimum of a) the 
room depth, b) 1.5 times 
the facade wall height, and 
c) 15 feet. 

Daylighting Zone # 2 
depth –total depth minus 
the Zone # 1 depth. 
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Min Power Fraction = 0.1 

Min Light Fraction = 0.05 

 

 

Figure 4-90.  Continuous light dimming based on daylight levels. 
(from the EnergyPlus Input/Output documentation) 

 

 Stepped:  Stepped lighting controls based on daylight levels. Min Power Fraction = 0, Min Light 
Fraction = 0, Number of Steps = 3, Probability of Reset = 1.0 (perfect occupants)  

 

 

Figure 4-91.  Stepped lighting controls based on daylight levels. 
(from the EnergyPlus Input/Output documentation) 

 

4.9.4.  Shading control 

 Glare view azimuth angle:  The glare calculation is performed assuming that the occupant faces 
the facade (glare view azimuth angle = 0) and is positioned at the first daylighting reference point 
(sensor #1). Presently the user cannot change the occupant’s position or glare view azimuth angle 
through the COMFEN interface. They can, however, change the glare view azimuth angle by 
accessing the comfen_setting.xml file in the settings folder. 
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 Maximum Glare Index:  The Maximum Glare Index is set to 22.  However, since there are not 
currently any dynamically controlled shading devices, no aspect of the facade changes above this 
glare index value. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 




